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About This Book

The Appliance Guide provides information about the requirements, initial configuration, and 
maintenance for the PlateSpin Transformation Manager Appliance and the PTM Server application.

 Part I, “Deploy PTM Appliance,” on page 9
 Part II, “Upgrade PTM Appliance and PlateSpin Migrate Connectors,” on page 37
 Part III, “Manage PTM Server Application,” on page 57
 Part IV, “Manage PTM Appliance,” on page 69

Intended Audience
This document is intended for IT administrators who will deploy and maintain the PlateSpin 
Transformation Manager Appliance. A basic knowledge of virtual machine deployment is assumed.

Additional Documentation
For the most recent version of this guide and other PlateSpin Transformation Manager 
documentation resources, visit the PlateSpin Transformation Manager 2019.2 Documentation 
website (https://www.microfocus.com/documentation/platespin/platespin-transformation-
manager-2019-2/).

Contact Information
For specific product issues, contact Micro Focus Support at https://support.microfocus.com/
contact/.

Additional technical information or advice is available from several sources:

 Product information and resources: https://www.microfocus.com/products/platespin/
transformation-manager/

 Micro Focus Customer Center: https://www.microfocus.com/customercenter/
 Product Knowledge Base and Videos: https://www.microfocus.com/support-and-services/
 Micro Focus Communities: https://www.microfocus.com/communities/
 PlateSpin Idea Exchange: https://community.softwaregrp.com/t5/PlateSpin-Idea-Exchange/

idb-p/PlateSpin_Ideas/
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I IDeploy PTM Appliance

The PlateSpin Transformation Manager Appliance is a virtual machine that hosts the PlateSpin 
Transformation Manager Server software, PostgreSQL database software, and PTM database 
instance for your transformation projects. The Appliance also hosts an instance of PlateSpin Migrate 
Connector that is preconfigured to work with all projects on the PTM server.

PlateSpin Transformation Manager is deployed as an appliance on your VM host environment. 
Appliance deployment provides the following benefits:

 Simple deployment. The appliance is ready to configure and run on your VMware hypervisor. 
You do not need to install the operating system, set up prerequisite applications, or configure its 
databases.

 Better performance. The appliance is built on a specific and tuned version of the SUSE Linux 
Enterprise Server (SLES) operating system. The appliance includes everything that PlateSpin 
Transformation Manager needs, and only what it needs. It omits the unneeded applications and 
services that can consume system resources.

 Web-based appliance administration. The appliance provides a web-based Appliance 
Management Console that allows you to easily manage the appliance in your environment. You 
do not need to understand the underlying operating system, software, or databases.
If you contact Technical Support with a PlateSpin Transformation Manager support incident, you 
might be asked to access a Linux terminal console on the Appliance as the root user. Your 
support representative will provide guidance on any required actions.

 Chapter 1, “PTM Appliance Requirements,” on page 11
 Chapter 2, “Installing PTM Appliance,” on page 21
 Chapter 3, “Configuring PTM Server,” on page 27
 Chapter 4, “Configuring PlateSpin Migrate Connector,” on page 29
 Chapter 5, “Post-Installation Tasks,” on page 31
Deploy PTM Appliance 9
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1 1PTM Appliance Requirements

Ensure that your system meets the requirements in this section before you begin the installation of 
the PlateSpin Transformation Manager Appliance.

 Section 1.1, “Appliance Virtualization Host Environment,” on page 11
 Section 1.2, “PTM Server,” on page 13
 Section 1.3, “PTM Database,” on page 14
 Section 1.4, “PTM Appliance Management Console,” on page 15
 Section 1.5, “PTM Web Interface,” on page 15
 Section 1.6, “Event Messages,” on page 16
 Section 1.7, “PlateSpin Migrate Connector,” on page 16
 Section 1.8, “Network Access and Communications,” on page 17

1.1 Appliance Virtualization Host Environment
You deploy the OVF file for the PlateSpin Transformation Manager Appliance on your virtualization 
host server.

 Section 1.1.1, “Virtualization Host Server,” on page 11
 Section 1.1.2, “Virtual Machine,” on page 12
 Section 1.1.3, “Virtual Storage,” on page 12
 Section 1.1.4, “NTP Configuration for the VM and Host,” on page 13

1.1.1 Virtualization Host Server
PlateSpin Transformation Manager supports the virtualization software described in Table 1-1.

Table 1-1   Virtualization Host Server Requirements

Virtualization Host Server Minimum Requirement Remarks

VMware ESXi 5.5 or higher The ESXi host must have a 
VMware enterprise license.

VMware vSphere Client 5.5 or higher Use this tool to set up the 
hypervisor environment and 
resources for the PTM Appliance 
VM.
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1.1.2 Virtual Machine
The OVF file creates a virtual machine on the virtualization host server. The minimum requirements 
for the PTM Appliance VM are described in Table 1-2.

Table 1-2   Virtual Machine Requirements

1.1.3 Virtual Storage
You must provide a boot disk and a data disk when you deploy the PTM Appliance. The minimum 
requirements for the PTM Appliance VM are described in Table 1-3.

Table 1-3   Virtual Storage Requirements

PTM Appliance VM Minimum Requirement Remarks

Memory 4 GB RAM This virtual memory size setting is 
the appliance default.

Processor 2 vCPUs This virtual CPU setting is the 
appliance default.

IP Address Information  Static IP address for the VM
 Network mask
 Gateway IP address
 DNS host name associated 

with the static IP address
 DNS server IP address
 NTP Server IP address or 

DNS name

Gather this information before 
you deploy the PTM Appliance. 
You must provide this information 
during the appliance installation.

Virtual Storage Minimum 
Requirements

Remarks

Disk 1 Boot 20 GB The boot partition for the PTM Appliance stores 
the system files:

 guest operating system
 all appliance-specific software
 appliance system event logs that are stored in 

the /var directory

This boot disk size is the appliance default.
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1.1.4 NTP Configuration for the VM and Host
Micro Focus recommends setting up NTP (Network Time Protocol) for the PTM Appliance VM and 
the virtualization host server in accordance with the VMware Time Keeping Best Practices for Linux 
Guests (KB 1006427) (https://kb.vmware.com/kb/1006427).

In a PlateSpin Migration Factory environment, consider using the same NTP server for all PlateSpin 
components to help avoid time drifts that might prohibit successful migration.

1.2 PTM Server
PlateSpin Transformation Manager Server software is automatically installed on the PlateSpin 
Transformation Manager Appliance when you deploy the appliance.

During the Appliance deployment, you will set up a System Administrator account for the PTM 
server and specify passwords for the local users of the Appliance. See Table 1-3 for information 
about these default users.

Table 1-4   PTM Default Users

Disk 2 /vastorage 20 GB or larger The /vastorage disk stores the software and 
data:

 PlateSpin Transformation Manager Server 
software

 PlateSpin Migrate Connector software
 PostgreSQL database with a PTM database 

instance
 Appliance configuration information
 Ganglia health metrics

You must create and add this virtual disk during 
the appliance installation.

Virtual Storage Minimum 
Requirements

Remarks

Default Users Description

vaadmin user password The vaadmin user is a default local Appliance 
administrator user with Linux root-level trans mgr.

Use the vaadmin credentials to log in to the 
Appliance Management Console.
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1.3 PTM Database
PlateSpin Transformation Manager automatically pre-installs the PostgreSQL database on the 
appliance. You can alternatively set up the PlateSpin Transformation Manager database as a 
database instance on an existing PostgreSQL database in your network. The minimum requirements 
for the PTM database are described in Table 1-5.

Table 1-5   PostgreSQL Database Requirements

root user password The root user is the default Linux administrator 
user for the PTM virtual machine.

Use the root user credentials if you need to log in 
directly to the VM through the VMware vSphere VM 
console or through SSH to a Linux console.

Technical Support might instruct you to access the 
Linux console on the Appliance with the root 
credentials.

PTM System Administrator The System Administrator user has global 
permissions throughout the PTM Web Interface. 
During the PTM configuration, specify a valid email 
address as the user name for this account, then 
specify a secure password.

Use the System Administrator credentials to log in to 
the PTM Web Interface after the Appliance is up and 
running. You add other PTM users by using the Users 
tab in the Web Interface. See “Users” in the PTM 
2019.2 Administrator Guide.

Default Users Description

Parameter Local (Default) Remote

Database Host localhost Specify the DNS name or IP 
address of the host server for the 
remote PostgreSQL database.

Database Port 5432 5432

(or your custom port)

Database administrator 
credentials

Automatically creates a 
PostgreSQL database 
administrator user and password

Specify the credentials of the 
database administrator user who 
has the schema rights necessary 
to create a new database instance 
for PTM and to create a new 
administrator user account for 
the new instance.

Create a New Database Selected Selected
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1.4 PTM Appliance Management Console
Most of your management interaction with the PlateSpin Transformation Manager Appliance takes 
place through the browser-based PlateSpin Transformation Manager Appliance Management 
Console.

 Section 1.4.1, “Supported Web Browsers,” on page 15

1.4.1 Supported Web Browsers
PlateSpin Transformation Manager supports the following web browsers for the Appliance 
Management Console:

 Google Chrome (latest version)
 Microsoft Internet Explorer 11
 Mozilla Firefox (latest version)

NOTE: You must enable JavaScript (Active Scripting) and the TLS 1.2 protocol in your web browser.

1.5 PTM Web Interface
User interaction with the PlateSpin Transformation Manager Server takes place through the 
browser-based PlateSpin Transformation Manager Web Interface.

 Section 1.5.1, “Supported Web Browsers,” on page 15

1.5.1 Supported Web Browsers
PlateSpin Transformation Manager supports the following web browsers for the PlateSpin Server 
Web Interface:

 Google Chrome (latest version)

Database Name transmgr transmgr

(or specify a custom name for the 
PTM database instance)

Database User Name tmadmin tmadmin

(or specify a custom user name 
and password for the database 
administrator user account that 
will be created for the new PTM 
database instance)

Parameter Local (Default) Remote
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 Microsoft Internet Explorer 11
 Mozilla Firefox (latest version)

NOTE: JavaScript (Active Scripting) must be enabled in your web browser.

1.6 Event Messages
PlateSpin Transformation Manager publishes workload workflow state change messages for its 
registered listeners. Each PlateSpin Migrate Connector instance registers with its assigned 
Transformation Manager server or project and listens for events and performs the appropriate 
actions.

In a PlateSpin Migration Factory environment, each PlateSpin Migrate server publishes workload 
migration state change messages for its registered listeners. Each PlateSpin Migrate Connector 
instance registers with its assigned Migrate servers, then listens for messages and delivers them to 
the appropriate project and workload in Transformation Manager.

PlateSpin uses RabbitMQ for event messaging. The event message queues are pre-configured on the 
PTM Server and the PlateSpin Migrate Server. The messaging function starts, stops, and restarts 
automatically with its parent PTM service or Migrate service, respectively.

NOTE: Do not modify the PlateSpin default settings for the RabbitMQ message service.

The PlateSpin Migrate message queues are inactive unless you open the required STOMP port on the 
Migrate Server. When the port is open, one or more PlateSpin Migrate Connector instances can 
register as subscribers for the event messages.

1.7 PlateSpin Migrate Connector
An instance of the PlateSpin Migrate Connector is automatically installed on the PlateSpin 
Transformation Manager Appliance. This Connector instance is preconfigured to work with all 
projects. It supports discovery and migration for source workloads in the same network where you 
deploy the appliance.

User interaction with the PlateSpin Migrate Connector takes place through a configuration file on 
the Appliance and global settings in the PlateSpin Transformation Manager Web Interface. You can 
use the configuration file to configure the Connector instance to work with a specific project instead 
of with all projects. See “Configuring a Connector Instance for PTM” in the PTM 2019.2 
Administrator Guide.

You can install additional instances of Migrate Connector on Linux servers in the same network as 
source workloads. See “Migrate Connector Requirements” in the PTM 2019.2 Administrator Guide.
16 PTM Appliance Requirements

https://www.microfocus.com/documentation/platespin/platespin-transformation-manager-2019-2/pdfdoc/ptm_admin/ptm_admin.pdf#pmcinstallreqtsos
https://www.microfocus.com/documentation/platespin/platespin-transformation-manager-2019-2/pdfdoc/ptm_admin/ptm_admin.pdf#pmcconfig


1.8 Network Access and Communications
Ensure that your network environment meets the PlateSpin Transformation Manager requirements 
for access, discovery, and migration.

For information about the network access requirements for PlateSpin Migrate, see “Access and 
Communication Requirements across Your Migration Network” in the PlateSpin Migrate 2019.2 User 
Guide.

 Section 1.8.1, “Public Internet Access,” on page 17
 Section 1.8.2, “Appliance Management Console: Ports and Firewalls,” on page 17
 Section 1.8.3, “PTM Web Interface: Ports and Firewalls,” on page 18
 Section 1.8.4, “Event Messaging: Ports and Firewalls,” on page 19

1.8.1 Public Internet Access
If VPN or WAN access is not available to remote locations in your migration environment, PlateSpin 
Transformation Manager must be able to communicate across the public Internet from the source 
environment to the target platform environment.

To provide Internet access through a proxy server, you must configure the PTM Appliance as a proxy 
client for your proxy server. See “Configure Proxy Client Settings” on page 31.

1.8.2 Appliance Management Console: Ports and Firewalls
PlateSpin Transformation Manager Appliance communications use the following ports. Ports are 
opened by default for the PTM Appliance, as noted. Ensure that you open the following ports in all 
firewalls in your network between the PTM Appliance and the computers you use to access the 
appliance and software.

Table 1-6   Communications Ports for Appliance Management

Component Port Description

Appliance Management Console 9443
(HTTPS, secure SSL)

Use this port to securely manage the PTM 
Appliance.

Transformation Manager Database 
(PostgreSQL)

5432 If you configure a remote PostgreSQL database 
for the PTM Appliance, this port is used by 
PTM to access to your remote database. 
PostgreSQL allows TCP traffic, incoming and 
outgoing. Secure traffic by enabling SSL in the 
postgresql.conffile on your remote 
PostgreSQL server.

This port is closed by default if the PostgreSQL 
is installed on the PTM Appliance.
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1.8.3 PTM Web Interface: Ports and Firewalls
PlateSpin Transformation Manager uses the following ports for PTM Server. Ensure that you open 
the following ports in all firewalls in your network between the PTM Appliance and the computers 
you use to access the appliance and the PTM-related services running on it.

Table 1-7   Communications Ports for the Transformation Manager Web Interface

SSH 22 You can use SSH to remotely access the PTM 
Appliance to start, stop, or restart it without 
using a VMware client.

SSH is disabled by default. See Section 12.4.1, 
“Starting, Stopping, or Restarting System 
Services,” on page 75.

Ganglia 8649 (secure, default)

9080 (non-secure)

The Ganglia gmond daemon uses UDP port 
8649 for communications.

The gmetad daemon uses TCP port 8649 for 
metrics data.

You can enable port 9080 to allow anonymous 
access to the Ganglia monitoring information. 
See Section 12.7.3, “View Ganglia Metrics 
Directly Using Port 9080 (Not Secure),” on 
page 82.

Component Port Description

Component Port Description

Web Interface 8183
(HTTPS, secure SSL; allow TCP 

traffic, incoming and outgoing)

8182
(HTTP, non-secure; allow TCP 

traffic, incoming and outgoing)

Port 8183 is enabled by default.

NOTE: Micro Focus recommends 
that you use the secure port and 
SSL options for accessing the Web 
Interface.

For security reasons, port 8182 is 
disabled by default.
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1.8.4 Event Messaging: Ports and Firewalls
Table 1-8 shows the protocol and port required for event messaging between the PTM Server and 
the PlateSpin Migrate Connector instances registered with PTM Server. Each Migrate Connector 
instance also handles event messages for its assigned PlateSpin Migrate servers.

NOTE: The messages reflect events and state changes and do not contain sensitive information.

Table 1-8   Event Messaging Requirements for Network Protocols and Ports

Traffic Network Protocol and Port Other Requirements

Event Messaging 61613 (Stomp, allow TCP, 
incoming)

(not secure)

This port is open by default on the 
PTM Appliance VM.

Open this port on all other 
Connector host servers, the 
PlateSpin Migrate servers 
configured for the project, and the 
firewalls between them.
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2 2Installing PTM Appliance

PlateSpin Transformation Manager is distributed as an appliance that you deploy on your VMware 
virtualization host. The appliance includes the PlateSpin Transformation Manager Server software 
and the PostgreSQL database.

NOTE: Before you begin, ensure that you understand the “PTM Appliance Requirements” on 
page 11.

 Section 2.1, “Downloading the PTM Software,” on page 21
 Section 2.2, “Deploying the Appliance on Your Virtualization Host,” on page 22
 Section 2.3, “Configuring the Appliance,” on page 24

2.1 Downloading the PTM Software
Installation files for PlateSpin Transformation Manager Appliance and PlateSpin Migrate Connector 
are available on the Micro Focus Downloads website (https://download.microfocus.com/). Select 
PlateSpin Transformation Manager, then follow the Download link for PlateSpin Transformation 
Manager 2019.2 in the results. Use your Micro Focus Customer Center account credentials to log in 
to this site.

Table 2-1 describes the installation files needed for PlateSpin Transformation Manager and PlateSpin 
Migrate Connector.

Table 2-1   PTM Download Files

Download File Name Description

PlateSpinTransformationManager-
2019_2.xx.ovf.zip
Where xx is the build number.

PlateSpin Transformation Manager 2019.2 Appliance

Contains the OVF file that you use to deploy the 
PlateSpin Transformation Manager Appliance in your 
virtualization environment.

You can also use the OVF file to deploy a replacement 
PTM Appliance for upgrades from version 2 to version 
2019.2, re-using the existing Disk 2 (/vastorage) 
that contains all essential configuration files and the 
PTM database. 
Installing PTM Appliance 21

https://download.microfocus.com/


To extract the OVF file:

1 Extract the <ptm-ovf-file-name>.zip file on your management workstation so that the 
PlateSpinTM-version file folder appears.
Extract the file by using a third-party extractor; do not use the default Windows extractor.

2 Continue with Section 2.2, “Deploying the Appliance on Your Virtualization Host,” on page 22.

2.2 Deploying the Appliance on Your Virtualization Host
Use the instructions in this section to deploy the PTM Appliance VM on your VMware host server 
and configure its virtual environment. Before you begin, ensure that you understand the Section 1, 
“PTM Appliance Requirements,” on page 11.

1 On the VMware host server, deploy the appliance:
1a In the vSphere client, click File > Deploy OVF Template.

If the virtualization software you are using does not support .ovf, you must convert the 
.ovf file to .vmx using the VMware OVF Tool available on the VMware Website.

1b Browse to and select the .ovf file in the PlateSpinTM-version file folder, then click 
Next.

1c Review the settings, then click Next.

platespin-migrate-connector-2019.2-
xx.x.x86_64.rpm
Where xx.x is the build number.

PlateSpin Migrate Connector 2019.2

Contains files to install PlateSpin Migrate Connector 
on Linux servers that you deploy in your migration 
environment. You can also use the RPM file to 
upgrade PlateSpin Migrate Connector from version 2  
to version 2019.2. 

NOTE: The Connector host server must meet 
software prerequisites. See “Supported Connector 
Host OS and Dependent Software” in the PTM 2019.2 
Administrator Guide.

An instance of the Migrate Connector is automatically 
installed on the Appliance when you deploy the 
Appliance VM.

ptm_public-key.key Contains the public key used for signing the PlateSpin 
Migrate Connector for new installations.

NOTE: To install the Migrate Connector RPM without 
warnings, you must import the PTM Public Key file to 
your keyring on the intended Migrate Connector host 
before you install the Connector RPM.

The key is not required for Migrate Connector 
upgrades from version 2 to version 2019.2 if you 
previously imported the key on the Connector host 
before you installed PlateSpin Migrate Connector 2.

Download File Name Description
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1d In the Name field, rename the appliance to a name of your choosing, then click Next.
1e Select the datastore (Hard Disk 1, the Boot partition) where you want to store the virtual 

machine files, then click Next.
1f Review the default disk format setting, then click Next to accept it.
1g Click Finish.

2 In the vSphere client, create a separate VMware hard disk (Hard Disk 2) for the PTM Appliance.
This hard disk stores your PlateSpin Transformation Manager files. It also stores configuration 
files that are used for appliance upgrades.
2a In the vSphere client, select the virtualization host where you set up the virtual machine, 

then click the Virtual Machines tab.
2b Right-click the virtual machine that you just created and for which you want to create 

secondary storage, then click Edit Settings.
2c On the Virtual Machine Properties page, select the Hardware tab, then click Add.
2d In the Add Hardware wizard, configure the hard disk.

Page Action

Device Type 1. Select Hard Disk, then click Next.

Select a Disk 1. Select Create a new virtual disk, then click Next.

Create a Disk 1. In the Capacity section, specify the amount of hard disk space that 
you want to allocate.
See Disk 2 /vastorage for information about minimum disk capacity 
requirements.

2. In the Disk Provisioning section, select either of the following disk 
formats, depending on the VMware version that you are running:
 Thick Provision Eager Zeroed
 Support clustering features such as Fault Tolerance

3. In the Location section, select Specify a datastore or datastore 
cluster, click Browse, select a datastore, then click OK.

4. Click Next.

Advanced Options 1. In the Virtual Device Node section, select SCSI (1:0) from the drop-
down list.
NOTE: Do not change the controller to VMware Paravirtual at this 
point of the installation process. You can optionally modify this 
setting as a post-installation task. See Section 5.3, “Change the SCSI 
Controller to VMware Paravirtual SCSI for Hard Disk 2,” on page 35.

2. In the Mode section, select Independent and Persistent.
These settings allow the appliance to be updated.

3. Click Next.

Summary 1. Review the specifications you set for the new hard disk, then click 
Finish.
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3 Increase the amount of memory that VMware allocates for the PTM Appliance.
3a In the Virtual Machine Properties window, select Memory, then increase the setting to a 

suitable size for your environment.
3b Click OK to exit the Virtual Machine Properties window.

4 (Optional) Upgrade the virtual machine hardware version to the latest that your infrastructure 
can support. To do so, in the vSphere client, right-click the virtual machine that you just created, 
and for which you want to upgrade the hardware, then click Upgrade Virtual Hardware.

5 Power on the appliance (virtual machine).
6 (Optional) Install VMware Tools on the host server.
7 Continue with Section 2.3, “Configuring the Appliance,” on page 24.

2.3 Configuring the Appliance
After you have successfully deployed the virtual machine in the virtual environment, you are ready 
to configure the credentials, network, and storage settings for the appliance.

1 In the vSphere client, power on the appliance.
2 Click the Console tab.
3 After the appliance starts, select your preferred keyboard layout in the Keyboard Language 

drop-down, then accept the End User License Agreement.
4 On the Passwords and Time Zone page, specify the following appliance information:

5 Click Next.
6 On the Network Configuration page, specify the following network information:

Option Action

root password Type the root user password that you want to set for the PTM Appliance, then 
type it again to confirm it.

vaadmin password Type the vaadmin user password that you want to set for the PTM Appliance, 
then type it again to confirm it.

The vaadmin user is the preferred identity to use when you log in to the 
Appliance Management Console. The vaadmin user name is case sensitive 
and should use all lowercase letters.

NTP Server Type the IP address or DNS name of a reliable external Network Time Protocol 
(NTP) server. For example, time.example.com.

For the best results, set up NTP in accordance with the VMware Timekeeping 
Best Practices for Linux Guests (http://kb.vmware.com/selfservice/microsites/
search.do?language=en_US&cmd=displayKC&externalId=1006427).

Region Specify your local region.

Time Zone Specify your local time zone.
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7 Click Next.
8 Select the Hard Drive for Hard Disk 2.

The Hard Disk 2 that you created for /vastorage is automatically detected and sdb is 
displayed as the hard drive. Accept the defaults for the other options on this page, then click 
Next.

9 Click Configure.
The appliance displays a message indicating that the installation was successful. Do not log in at 
the terminal prompt. Appliance administration requires the Appliance Management Console to 
configure the appliance settings. Using native Linux tools can result in service disruption or 
failure.

10 Continue with Section 3, “Configuring PTM Server,” on page 27.

Option Action

Hostname Type the fully qualified DNS host name associated with the appliance IP 
address. For example, ptm.example.com.

IP address Type the static IP address for the PTM Appliance. For example, 10.10.10.10.

Network mask Type the network mask associated with the appliance IP address. For example, 
255.255.255.0.

Gateway Type the IP address of the gateway on the subnet where your appliance is 
located. For example, 10.10.10.254.

DNS servers Type the IP address of a primary DNS server for your network. For example, 
10.10.10.1. A secondary DNS server is optional.

Domain search Type the domain that is associated with the Hostname setting.
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3 3Configuring PTM Server

After you install and configure the PlateSpin Transformation Manager Appliance as described in 
Part I, “Deploy PTM Appliance,” on page 9, you are ready to configure the PlateSpin Transformation 
Manager Server application for the first time.

 Section 3.1, “Initial PTM Server Configuration,” on page 27

After the initial configuration of PTM Server, you can modify some settings. Reconfiguration is also 
possible. See Chapter 10, “Managing PTM Server,” on page 59.

3.1 Initial PTM Server Configuration
The Server Configuration process uses a quick wizard that gets your system up and running.

To configure the PlateSpin Transformation Manager Server application:

1 In a web browser, navigate to the following URL:
https://ip_address_or_DNS_name:9443
Use the IP address or DNS name of the server that you specified during the appliance 
installation.

2 Log in to the appliance using the vaadmin user and the password that you set.
The Appliance takes you directly to the PlateSpin Transformation Manager Server Initial Server 
Configuration page if the PTM Server application has never been configured.

3 On the Initial Server Configuration page, complete the following information, then click Submit.

3a PostgreSQL Database Connection
Use one of the following options:
 Local database: PlateSpin Transformation Manager automatically pre-installs the 

PostgreSQL database on the appliance. Select Auto Setup Local Database to 
automatically create a database instance, database administrator user, and a 
password for the user. Table 3-1 shows the default settings.

Table 3-1   PostgreSQL Database Default Values

Parameter Default Value

Database Host localhost

Database Port 5432

Create a New Database Selected

Database Name transmgr

Database User Name tmadmin
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 Remote database: You can alternatively set up the PlateSpin Transformation Manager 
database as a database instance on an existing PostgreSQL database in your network.

1. Deselect Auto Setup Local Database.
2. Replace localhost with the DNS name or IP address of the host server for the 

remote PostgreSQL database, and specify the PostgreSQL port.
3. Specify the credentials of the database administrator user who has the schema 

rights necessary to create a new instance for the PlateSpin Transformation 
Manager database.

4. Specify a name for the PlateSpin Transformation Manager database instance 
(default: transmgr).

5. Specify the user name and password for the database administrator user account 
(default: tmadmin) that will be created for the newly created PlateSpin 
Transformation Manager database instance.

3b Initial User Configuration
The initial user for the PlateSpin Transformation Manager Server is the PTM System 
Administrator user. This user has global permissions for all organizations, projects, and 
features throughout the Web Interface.
Provide the full name, a valid email address that is unique to your PlateSpin Transformation 
Manager environment, and a password for this user.
You cannot delete the System Administrator user account. However, you can add another 
System Administrator user for the PlateSpin Transformation Manager Server if necessary. 
See “Administrative Users for the Web Interface”.

NOTE: You create other PTM users from the Users page in the PlateSpin Transformation 
Manager Web Interface. You can grant Administrator privileges to trusted users by adding 
them to the Administrators group. 

3c Web Server Configuration
Micro Focus recommends that you use the secure port 8183 and SSL options for accessing 
the Web Interface. You can enable or disable the HTTP port 8182 to allow non-secure 
traffic.
Specify the DNS name for the PlateSpin Transformation Manager Server. It is populated 
automatically with the DNS address used as the subject of the SSL certificate on the 
appliance.

4 On successful configuration, continue with Chapter 5, “Post-Installation Tasks,” on page 31.
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4 4Configuring PlateSpin Migrate Connector

An instance of the PlateSpin Migrate Connector is automatically installed on the PlateSpin 
Transformation Manager Appliance. This Connector instance is preconfigured to work with all 
projects. It supports discovery and migration for source workloads in the same network where you 
deploy the appliance. Table 4-1 provides information about configuring, deploying, and managing 
Migrate Connectors in your migration environment.

Table 4-1   Migrate Connector Configuration Checklist

Connector Configuration Tasks Description

1. Configure Migrate Connector global settings. In 
the Web Interface, select Configuration > 
Migrate Connector.

Migrate Connector settings in PTM apply to all 
Migrate Connectors associated with the PTM Server 
across all projects.

See “Configuring Global Settings for PlateSpin 
Migrate Connector” in the PTM 2019.2 
Administrator Guide.

2. (Optional) Configure the Connector instance to 
work with a specific project instead of with all 
projects.

After you create a project, you can use its Project ID 
to configure a Connector instance to work with a 
specific project.

See “Configuring a Dedicated Project for a 
Connector” in the PTM 2019.2 Administrator Guide.

3. (Optional, recommended) Create a special-
purpose user for Migrate Connector.

The default instance of Migrate Connector on the 
PTM Appliance uses the credentials of the PTM 
System Administrator user to perform actions. We 
recommend that you create a unique user identity 
for the Connector instance instead. Having a unique 
Connector user for each Migrate Connector helps 
you more easily distinguish actions performed by 
the Connector instance in logs and transformation 
histories.

See “Creating a User for Connector Login” in the 
PTM 2019.2 Administrator Guide.

4. (PlateSpin Migration Factory) Add one or more 
PlateSpin Migrate servers as Migration Server 
resources and associate them with the 
Connector instance.

In a PlateSpin Migration Factory environment, a 
Connector instance is required for automating 
migrations or tracking migrations performed on 
your PlateSpin Migrate servers. Users with Project 
Manager or Project Architect permissions can assign 
a Connector by creating or editing a Migration 
Server resource.

See “Connector” in “About Migration Server 
Resources” in the PTM 2019.2 User Guide.
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5. Monitor Connector status. See “Monitoring Connectors” in the PTM 2019.2 
Administrator Guide.

6. (Optional) Install additional instances of 
Migrate Connector on your Linux servers.

Migrate Connector instances are typically deployed 
in each source network and in target VMware 
networks if they are different than your source 
networks.

See “Planning for PlateSpin Migrate Connector” and 
“Deploying PlateSpin Migrate Connector” in the 
PTM 2019.2 Administrator Guide.

Connector Configuration Tasks Description
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5 5Post-Installation Tasks

After you set up the appliance, perform the following post-installation tasks as needed:

 Section 5.1, “Configure Proxy Client Settings,” on page 31
 Section 5.2, “Add a Self-Signed Digital Certificate to the Appliance,” on page 35
 Section 5.3, “Change the SCSI Controller to VMware Paravirtual SCSI for Hard Disk 2,” on 

page 35
 Section 5.4, “View or Modify Appliance Settings,” on page 35
 Section 5.5, “Getting Started with PTM,” on page 35
 Section 5.6, “PlateSpin Migrate Connector Instances,” on page 36

5.1 Configure Proxy Client Settings
If you have a proxy server in your network, you can optionally configure the PlateSpin 
Transformation Manager Appliance VM as a proxy client. You should also configure each PlateSpin 
Migrate Connector host in the network as a proxy client. As proxy clients, the appliance VM and 
Connector hosts will use your proxy server for HTTP and HTTPS communications over the Internet.

The Proxy client informs applications of the Proxy Server URL and credentials to use (if you specify 
them). It does not affect how the applications communicate with the server.

 Section 5.1.1, “Configuring Proxy Client Settings for the PTM Appliance,” on page 31
 Section 5.1.2, “Configuring Proxy Client Settings for Migrate Connector Hosts,” on page 34

5.1.1 Configuring Proxy Client Settings for the PTM Appliance
You can enable the PlateSpin Transformation Manager Appliance to work with the Proxy Server in 
your environment. The PTM Server, PlateSpin Migrate Connector instance, PTM Web Interface, and 
Appliance Management Console running on the Appliance will use the proxy client settings you set 
for the Appliance VM.

To configure proxy client settings, log in to the Appliance VM through SSH, then use YaST to 
configure the Internet proxy client settings compatible with your proxy server.

To configure proxy client settings on the PTM Appliance VM:

1 Enable the SSH protocol on the Appliance VM.
SSH is disabled by default on the Appliance.
1a In a web browser, log in to the Appliance Management Console as the vaadmin user.

https://<ptm-ipaddr-or-dns-name>:9443

1b Click System Services .
1c Select the SSH service.
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1d Select Action > Start.
1e Click Close to exit System Services.
1f Log out of the Appliance Management Console, then close your web browser.

2 Configure the Proxy client settings needed to access your Proxy Server:
2a From your computer, start an SSH session for ptm-ipaddr-or-dns-name on port 22, then log 

in as the root user to the Appliance.
You can use any SSH tool, such as Putty (http://www.putty.org/).

2b At the terminal prompt, enter

yast

2c In YaST, navigate to Network Services, select Proxy, then press Enter.

2d On the Proxy Configuration page, on Enable Proxy, press the Space bar to select the check 
box.
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2e Tab to navigate to the fields and configure the Proxy settings by using the information for 
your Proxy Server. Provide the URL for the Proxy Server for HTTP or HTTPS (or both) 
communications, depending on what protocols you enabled for the Appliance.
HTTP Proxy URL: The URL (with host name and port number) of the Proxy Server used for 
non-secure access to the Internet. For example: http://proxy1.example.com:3126/
HTTPS Proxy URL: The URL (with host name and port number) of the Proxy Server used for 
secure access to the Internet. For example: https://proxy2.example.com:3128/
FTP Proxy URL: The URL (with host name and port number) of the Proxy Server used for 
access to the file transfer services (FTP). For example: https://
ftp.proxy.example.com:2121/
Use the Same Proxy for All Protocols: Enable this option and provide a single URL in HTTP 
Proxy URL that will be used as the Proxy Server for HTTP, HTTPS, and FTP communications.
No Proxy Domains: Specify a comma-separated list of domains for which requests should 
be made directly without caching. The default is localhost.
Proxy User Name and Proxy Password: Provide the credentials for your Proxy Server if it 
requires authorization.

2f (Optional) Tab to Test Proxy Settings, then press Enter.
2g Tab to OK, then press Enter to save and apply the settings.
2h Tab to Quit, then press Enter to exit YaST.
2i At the terminal prompt, enter exit to close the SSH session.

3 (Optional) Disable the SSH protocol on the Appliance.
3a In a web browser, log in to the Appliance Management Console as the vaadmin user.

https://<ptm-ipaddr-or-dns-name>:9443

3b Click System Services .
3c Select the SSH service.
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3d Select Action > Stop.
3e Click Close to exit System Services.
3f Log out of the Appliance Management Console, then close your web browser.

5.1.2 Configuring Proxy Client Settings for Migrate Connector Hosts
You can enable the PlateSpin Migrate Connector host servers to work with the Proxy Server in your 
environment. The Connector instance will use the proxy client settings you set for the Connector 
host.

On SUSE Linux Enterprise Server (SLES) servers that host an instance of Migrate Connector, log in to 
the desktop and use YaST2 to configure the Internet proxy client settings compatible with your proxy 
server.

NOTE: YaST2 is a management tool for SUSE Linux Enterprise operating system. If your Connector 
host runs a different Linux operating system, use the OS management tool from your Linux vendor to 
apply the settings described in this procedure.

To configure proxy client settings on SLES servers that host a Migrate Connector instance:

1 Log in as the root user to the desktop on the SLES server.
2 Start the YaST Control Center from the main menu. Provide the root user password if you are 

prompted for it.
To start the YaST Control Center from the command line, open a terminal, then enter yast2.

3 Select Network Services, then select Proxy.
4 Configure the Proxy settings by using the information for your Proxy Server. Provide the URL for 

the Proxy Server for HTTP and HTTPS communications.
HTTP Proxy URL: The URL (with host name and port number) of the Proxy Server used for non-
secure access to the Internet. For example: http://proxy1.example.com:3126/
HTTPS Proxy URL: The URL (with host name and port number) of the Proxy Server used for 
secure access to the Internet. For example: https://proxy2.example.com:3128/
FTP Proxy URL: The URL (with host name and port number) of the Proxy Server used for access 
to the file transfer services (FTP). For example: https://ftp.proxy3.example.com:2121/
Use the Same Proxy for All Protocols: Enable this option and provide a single URL in HTTP Proxy 
URL that will be used as the Proxy Server for HTTP, HTTPS, and FTP communications.
No Proxy Domains: Specify a comma-separated list of domains for which requests should be 
made directly without caching. The default is localhost.
Proxy User Name and Proxy Password: Provide the credentials for your Proxy Server if it 
requires authorization.

5 Click Test Proxy Settings.
6 Click Finish to save and apply the settings.
7 Exit YaST.
8 Log out of the server.
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5.2 Add a Self-Signed Digital Certificate to the Appliance
The appliance ships with a self-signed digital certificate. The certificate works for both the appliance 
(port 9443) and the PlateSpin Transformation Manager software (ports 8182 and 8183).

NOTE: This configuration task is optional. For higher security, Micro Focus recommends that you use 
a trusted server certificate that is signed by a trusted certificate authority (CA) such as VeriSign or 
Equifax.

You can use your own existing signed certificate, or you can use the Digital Certificate tool on the 
appliance to create a certificate, have it signed by a trusted certificate authority, and then add it to 
the appliance. See Section 12.5, “Digital Certificates,” on page 77.

5.3 Change the SCSI Controller to VMware Paravirtual SCSI 
for Hard Disk 2
For Hard Disk 2, you can optionally change the SCSI controller to VMware Paravirtual (PVSCSI) for 
Hard Disk 2.

NOTE: This configuration task is optional.

1 After the installation is complete, power on the appliance.
2 Ensure that the system is running. Log in as the appliance vaadmin user and verify the health of 

the appliance and services.
3 Shut down the appliance.
4 In VMware, change the SCSI controller for Hard Disk 2 to VMware Paravirtual.
5 Power on the appliance.

5.4 View or Modify Appliance Settings
After you configure the PTM Server for the first time, you can view or modify the PTM Appliance 
settings by using the Appliance Management Console to access the Appliance System Configuration 
page. See Chapter 12, “Managing PTM Appliance,” on page 71.

5.5 Getting Started with PTM
The PTM System Administrator user performs administrative tasks through the PTM Web Interface 
to prepare PTM for project users. See the following topics in the PTM 2019.2 Administrator Guide.

 Section 5.5.1, “Configure Global PTM Settings,” on page 36
 Section 5.5.2, “Configure Users,” on page 36
 Section 5.5.3, “Configure Transformation Projects,” on page 36
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5.5.1 Configure Global PTM Settings
Use the PlateSpin Transformation Manager Web Interface to configure and manage the software. 
See the following in the PTM 2019.2 Administrator Guide:

 “Accessing the Web Interface”
 “Configuring Operating Systems”
 “Configuring Global Settings for PlateSpin Migrate Connector”

5.5.2 Configure Users
Use the PlateSpin Transformation Manager Web Interface to add users and assign PTM user roles to 
them. See “Users” in the PTM 2019.2 Administrator Guide.

5.5.3 Configure Transformation Projects
After an Administrator user configures global settings and assigns project roles, the PlateSpin 
Transformation Manager Web Interface is ready for users to plan, manage, and execute 
transformation projects. See the following topics in the PTM 2019.2 User Guide:

 “Projects”
 “Target Platforms”
 “Workloads”
 “Resources”

5.6 PlateSpin Migrate Connector Instances
If a source network or target VMware network is in a different network than the PTM Appliance, you 
must deploy an instance of PlateSpin Migrate Connector on a Linux server in that network. See the 
PlateSpin Migrate Connector 2019.2 Installation Quick Start.
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II IIUpgrade PTM Appliance and PlateSpin 
Migrate Connectors

PlateSpin Transformation Manager supports upgrade of PlateSpin Transformation Manager from 
version 2 to version 2019.2. After you upgrade PTM, you must upgrade each PlateSpin Migrate 
Connector from version 2 to version 2019.2. In a PlateSpin Migration Factory environment, you must 
also upgrade all PlateSpin Migrate servers from version 2018.11 to version 2019.2.

This section describes the requirements, prerequisites, and process for the upgrade.

 Chapter 6, “Upgrade Requirements,” on page 39
 Chapter 7, “Upgrading PlateSpin Transformation Manager,” on page 43
 Chapter 8, “Upgrading PlateSpin Migrate Connector on Host Servers,” on page 51
 Chapter 9, “Upgrading PlateSpin Migrate Servers,” on page 55
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6 6Upgrade Requirements

Before you upgrade your PlateSpin Transformation Manager environment, ensure that you 
understand the requirements for upgrade.

 Section 6.1, “Supported Upgrade Paths,” on page 39
 Section 6.2, “PlateSpin Migration Factory Requirements,” on page 40
 Section 6.3, “Required Order of Upgrade,” on page 41
 Section 6.4, “PlateSpin Upgrade Checklist,” on page 41

6.1 Supported Upgrade Paths
PlateSpin Transformation Manager is integrated with one or more PlateSpin Migrate Connectors. In 
a PlateSpin Migration Factory deployment, it is also integrated with one or more PlateSpin Migrate 
servers. A PTM upgrade involves upgrading all three components. 

 Section 6.1.1, “PlateSpin Transformation Manager Appliance,” on page 39
 Section 6.1.2, “PlateSpin Migrate Connector,” on page 39

6.1.1 PlateSpin Transformation Manager Appliance
PlateSpin Transformation Manager supports upgrade from PlateSpin Transformation Manager 2 to 
PlateSpin Transformation Manager 2019.2. Other direct upgrades are not supported. 

To upgrade, you use the download OVF file to create a new appliance VM and re-use the existing 
Disk 2 (/vastorage). When PTM completes the upgrade, PTM applies the configuration settings 
stored on Disk 2 (/vastorage) to the software on the replacement appliance VM. It applies the 
database schema changes to the PTM database on the disk. See Chapter 7, “Upgrading PlateSpin 
Transformation Manager,” on page 43.

NOTE: PlateSpin Transformation Manager does not support an in-place version upgrade of PlateSpin 
Transformation Manager software on the existing appliance VM.

6.1.2 PlateSpin Migrate Connector
PlateSpin Transformation Manager 2019.2 Appliance includes PlateSpin Migrate Connector 2019.2. 
When PTM completes the Appliance upgrade, PTM applies the Connector configuration settings 
stored on Disk 2 (/vastorage) to the Connector software on the replacement appliance VM.

For other Connector instances in your migration environment, PlateSpin Migrate Connector 
supports in-place upgrades from PlateSpin Migrate Connector 2 to PlateSpin Migrate Connector 
2019.2. Other direct upgrades are not supported. See Chapter 8, “Upgrading PlateSpin Migrate 
Connector on Host Servers,” on page 51.
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NOTE: Ensure that you upgrade the PTM Appliance before you begin upgrades for your remote 
Connector instances. 

6.2 PlateSpin Migration Factory Requirements
PlateSpin Migration Factory brings a project-management approach to large-scale cloud and data-
center migrations. PlateSpin Transformation Manager and PlateSpin Migrate work seamlessly 
together to provide discovery, planning, execution, and visualization of migrations for enterprise-
grade servers. Migration execution can be fully automated, semi-automated, and manual, with 
tracking in PTM across all participating Migrate servers.

PlateSpin Migration Factory 2019.2 supports the following PlateSpin software:

 PlateSpin Transformation Manager 2019.2

PlateSpin Transformation Manager provides planning, tracking, and automation solutions for 
PlateSpin Migration Factory. 

PlateSpin Migrate Connector, a component of PTM, is deployed in your migration environment 
to provide the following services for PlateSpin Migration Factory:
 Supports workload and target platform discovery
 Load-balances the assignment of migration jobs across its participating PlateSpin Migrate 

servers
 Manages communications for the execution and monitoring of transformation plans

PlateSpin Transformation Manager 2019.2 and PlateSpin Migrate Connector 2019.2 support 
PlateSpin Migrate 2019.2. 

 PlateSpin Migrate 2019.2
PlateSpin Migrate provides discovery, configuration, and migration execution solutions for 
PlateSpin Migration Factory. 
PlateSpin Transformation Manager executes automated migrations on PlateSpin Migrate 
servers and tracks external migrations performed on them. Other discovery and planning 
features in PTM do not require PlateSpin Migrate servers. 
PlateSpin Migrate 2019.2 supports PlateSpin Transformation Manager 2019.2 and PlateSpin 
Migrate Connector 2019.2. In an existing PlateSpin Migration Factory migration environment, 
you must upgrade your existing PlateSpin Migrate 2018.11 servers to PlateSpin Migrate 2019.2. 
See “Upgrading PlateSpin Migrate” in the PlateSpin Migrate 2019.2 Installation and Upgrade 
Guide.
For information about how to buy this product, see PlateSpin Migrate (https://
www.microfocus.com/products/platespin/migrate/).
For information about installing and using this product, see the PlateSpin Migrate 2019.2 
Documentation website (https://www.microfocus.com/documentation/platespin/platespin-
migrate-2019-2/).
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6.3 Required Order of Upgrade
1. Upgrade the PlateSpin Transformation Manager Appliance.

 Communications will fail between the upgraded PTM Server and each remote PlateSpin 
Migrate Connector instance (if any) until you upgrade that Connector.

 Communications will fail between the upgraded local instance of PlateSpin Migrate 
Connector and each of its assigned PlateSpin Migrate servers (if any) until you upgrade that 
Migrate server.

2. Upgrade each remote PlateSpin Migrate Connector instance.
Communications will fail between an upgraded remote PlateSpin Migrate Connector and each 
of its assigned PlateSpin Migrate servers (if any) until you upgrade that Migrate server.

3. After you upgrade a Connector, you can begin to upgrade the PlateSpin Migrate servers 
assigned to that Connector. Repeat this process for each Connector.

4. When the upgrade is complete for all PlateSpin Migration Factory components is complete, you 
can resume migration activities.

6.4 PlateSpin Upgrade Checklist
Table 6-1   PlateSpin Upgrade Checklist

Task Description

1. Upgrade the PTM Appliance from version 2 to 
version 2019.2.

See Chapter 7, “Upgrading PlateSpin Transformation 
Manager,” on page 43.

2. If you have installed instances of PlateSpin 
Migrate Connector 2 on your Linux servers, you 
must upgrade the Connector software to 
version 2019.2. 

Upgrade the software for each Connector associated 
with each project. See Chapter 8, “Upgrading 
PlateSpin Migrate Connector on Host Servers,” on 
page 51.

3. If you have PlateSpin Migrate 2018.11 servers 
defined for the Project, you must upgrade 
them to PlateSpin Migrate 2019.2. 

After you have updated the Connectors for a 
project, you can begin to upgrade the PlateSpin 
Migrate servers associated with the project.

See Chapter 9, “Upgrading PlateSpin Migrate 
Servers,” on page 55.

4. After the project’s Connector instances and 
their associated Migrate servers have been 
upgraded:

1. (Automated migrations) For automated 
migrations controlled by PTM, resume 
replications and migrations. In the PTM Web 
Interface, remove the On Hold state for 
workloads.

2. (Tracked migrations) For tracked migrations 
controlled by PlateSpin Migrate, resume 
replications and migrations. In the Migrate 
Web Interface, un-pause schedules for 
workloads.

5. Allow PTM users to access the PTM Web 
Interface to resume project activities.

Inform users that the upgrade is complete and the 
migration environment is ready for use.
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7 7Upgrading PlateSpin Transformation 
Manager

To upgrade from PlateSpin Transformation Manager 2 to PlateSpin Transformation Manager 2019.2, 
you will deploy a replacement virtual machine image for PlateSpin Transformation Manager 2019.2 
Appliance, and re-use Disk 2 (/vastorage). All PTM configuration files and the PTM database are 
stored on the disk that is mounted at /vastorage. You will copy Disk 2 to the new deployment 
location and attach it to the replacement virtual machine during its deployment. 

The PTM 2019.2 Appliance OVF file provides an new appliance template with the following changes:

 PlateSpin Transformation Manager Server and any software package dependencies
 PlateSpin Migrate Connector and any software package dependencies
 PlateSpin Database schema changes

The upgrade deployment opens the Appliance Management Console and prompts you to set 
passwords for the vaadmin user and root user for the new appliance, and then completes the 
upgrade. PTM reads the existing configuration files on Disk 2, and applies those settings to the 
replacement appliance, and then applies database schema changes to the database stored on Disk 2.

NOTE: The VM replacement process takes only about 5 minutes until you are up and running again.

 Section 7.1, “Preparing for Upgrade,” on page 44
 Section 7.2, “Before You Upgrade,” on page 46
 Section 7.3, “Deploying a Replacement Appliance VM,” on page 48
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7.1 Preparing for Upgrade
Before you begin the upgrade, ensure that you meet the “Upgrade Requirements” on page 39 and 
perform the preparatory tasks in Table 7-1. 

Table 7-1   Checklist for Preparing to Upgrade PlateSpin Transformation Manager

Status Prerequisite Task Notes

 1. Download the PlateSpin Transformation 
Manager 2019.2 OVF file.

See Section 2.1, “Downloading the PTM 
Software,” on page 21.

1. Download the <ptm-ovf-file-
name>.zip file to the management 
workstation where you are running the 
VMware vSphere Client or using the 
vSphere Web Client in a web browser.

2. Extract the ZIP file by using a third-party 
extractor; do not use the default 
Windows extractor. 

 2. (Automated migrations) Ensure that no 
PTM-controlled automated migrations or 
replications are in progress.

For automated migrations controlled by PTM, 
wait until in-progress migrations are complete, 
or pause migration schedules by placing the 
workloads in an On Hold state. Wait for in-
progress replications to complete, or abort 
them.

NOTE: Workload migrations must remain in 
the On Hold state until after you have 
completed the upgrades for the PTM 
Appliance, all Migrate Connector instances, 
and all PlateSpin Migrate servers.

 3. (Tracked migrations) For PlateSpin 
Migrate servers, ensure that no PTM-
tracked migrations or replications are in 
progress.

For migrations being tracked by PTM, wait 
until in-progress migrations are complete, or 
pause migration schedules by using Pause 
Schedule for the workloads in Migrate. Wait 
for in-progress replications to complete, or 
abort them. 

NOTE: Workload migrations must remain in 
the Paused Schedule state until after you have 
completed the upgrades for the PTM 
Appliance, all Migrate Connector instances, 
and all PlateSpin Migrate servers.

 4. Log out of PTM Web Interface (all users) 
and close the web browser.

You should not attempt to manage workloads 
and migrations during the upgrade.
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 5. On each remote PlateSpin Migrate 
Connector host server, stop the Migrate 
Connector instance from running. 

There should be no Connector 
communications with the replacement PTM 
Appliance until the Connector software has 
also been upgraded.

In a console on each Connector host server, 
enter:

rcps_migrate_connector stop

 6. (Optional) If you ever modified the Jetty 
settings on the Appliance, establish an 
SSH session with the Appliance and save 
your Jetty settings.

See Section 7.2.1, “Save Jetty Settings,” on 
page 46.

 7. (Optional) If you ever modified the 
default theme settings files without 
copying them to a custom location, save 
a copy of the existing default files.

See Section 7.2.2, “Save Customized Default 
Theme Files,” on page 46.

 8. Log in to the PTM Appliance 
Management Console and shut down the 
PlateSpin Migrate Connector for PTM 
service, then shut down the PlateSpin 
Transformation Manager service.

See Section 12.4.1, “Starting, Stopping, or 
Restarting System Services,” on page 75.

Wait until the services stop before you 
continue.

 9. Log out of the PTM Appliance 
Management Console and close the web 
browser.

Do not log in to the Appliance Management 
Console again except as directed to complete 
the upgrade.

 10. Log in to VMware vSphere for the 
Appliance host, then power down the 
Appliance VM gracefully.

At shutdown, PTM copies essential 
configuration files to the /vastorage/
conf/ folder, including the configuration for 
the Migrate Connector instance installed on 
the Appliance.

See Section 7.2.3, “Archive Essential 
Configuration Files,” on page 47.

 11. In vSphere, create a VM folder where you 
will create the 2019.2 appliance. 

Name the folder something relevant (such as 
ptm-2019-2-<ip-address>).

 12. In vSphere, copy the Disk 2 .vmdk (/
vastorage) from the old VM folder to 
the new VM folder.

Disk 2 contains all essential PTM and 
Connector configuration files and the PTM 
database.

 13. Ensure that the person who deploys the 
replacement appliance is a trusted user.

The upgrade requires the user to set a 
password for the vaadmin user and root 
user on the replacement appliance.

 14. Deploy the replacement PTM appliance. Continue with Section 7.3, “Deploying a 
Replacement Appliance VM,” on page 48.

Status Prerequisite Task Notes
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7.2 Before You Upgrade
Perform the following tasks as needed before you upgrade the Appliance.

 Section 7.2.1, “Save Jetty Settings,” on page 46
 Section 7.2.2, “Save Customized Default Theme Files,” on page 46
 Section 7.2.3, “Archive Essential Configuration Files,” on page 47

7.2.1 Save Jetty Settings
If you ever modified the Jetty configuration settings on the existing Appliance, your custom settings 
will be lost when you replace the Appliance during upgrade. Copy the settings to /vastorage, or 
make a note of the settings so you can re-configure them after the upgrade.

To copy the Jetting configuration settings:

1 Enable SSH on the PTM Appliance.
See Section 12.4.4, “Enabling or Disabling the SSH Service,” on page 76

2 From your management computer, start an SSH session for ptm-ipaddr-or-dns-name on port 22, 
then log in as the root user to the Appliance.
You can use any SSH tool, such as Putty (http://www.putty.org/).

3 Save a copy of the /opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/
ssl.ini file, or make a note of the Jetty keystore settings for the following parameters. The 
default values for PTM are shown here. Your settings might be different if you have ever made 
changes to the Jetty keystore using the appropriate keytool software. You will need to reset 
these keystore settings after the upgrade. Changeit is the actual password value in this 
example.

# Setup a keystore and truststore
jetty.keystore=certs/keystore
jetty.truststore=certs/keystore

# Set the passwords.
jetty.keystore.password=changeit
jetty.keymanager.password=changeit
jetty.truststore.password=changeit

7.2.2 Save Customized Default Theme Files
If you customized the theme in PlateSpin Transformation Manager, you might need to save a copy of 
your files, depending on how you applied your theme.

 Custom Theme in a separate folder: If you created a new custom theme (copied default 
themes to new directory and edited), the custom theme is saved in /vastorage and will be 
available after you upgrade the PTM Appliance. 

After the upgrade, you must copy the new default theme files and re-create your custom theme 
by merging your settings into the latest format. See Section 11.3, “Resetting Your Custom 
Theme after an Upgrade,” on page 67.
46 Upgrading PlateSpin Transformation Manager

http://www.putty.org/


 Customized default theme files: If you customized the default theme files in the default 
location (/vastorage/ptm/themes/ directory), your changes will be overwritten when you 
deploy a new Appliance. 
Before you upgrade the PTM Appliance, go to the /vastorage/ptm/themes/ directory, then 
save your customized default theme files to a location where they will be available after the 
upgrade. 
After the upgrade, you can reapply your custom settings to the new default theme files. See 
Section 11.1, “Configurable Theme Components,” on page 65. Alternatively, create a custom 
theme. See Section 11.2, “Setting Up Your Custom Theme,” on page 66.

7.2.3 Archive Essential Configuration Files
When you shut down the PlateSpin Transformation Manager Appliance in the Appliance Shutdown 
step, PTM automatically archives essential configuration files in the vaconfig.zip file in the /
vastorage/conf/ folder on Disk 2 (/vastorage).

Archive:  vaconfig.zip
 extracting: etc/sysconfig/novell/NvlVAinit
 extracting: etc/Novell-VA-release
 extracting: usr/lib64/jvm/java/jre/lib/security/cacerts
 extracting: etc/opt/novell/ganglia/monitor/gmond.conf
 extracting: etc/opt/novell/ganglia/monitor/gmetad.conf
 extracting: etc/opt/novell/ganglia/monitor/net.d/recv.conf
 extracting: etc/opt/novell/ganglia/monitor/net.d/send.conf
 extracting: etc/sysconfig/SuSEfirewall2
 extracting: etc/sysconfig/scripts/SuSEfirewall2-custom
 extracting: etc/ssh/sshd_config
 extracting: etc/opt/microfocus/ps_transform_mgr/config/system.properties
 extracting: etc/opt/microfocus/ps_transform_mgr/config/quartz-scheduler.cfg
 extracting: etc/opt/microfocus/ps_transform_mgr/config/pgusr.in
 extracting: etc/opt/microfocus/ps_transform_mgr/config/connector.properties
 extracting: etc/opt/microfocus/ps_transform_mgr/config/war-tm-config.xml
 extracting: etc/opt/microfocus/ps_transform_mgr/config/com.netiq.tm.backend.auth.cfg
 extracting: etc/opt/microfocus/ps_transform_mgr/config/transformationmanager-themes.cfg
 extracting: etc/opt/microfocus/ps_transform_mgr/config/com.netiq.tm.backend.connpool.cfg
 extracting: etc/opt/microfocus/ps_transform_mgr/config/security/tm_cert.der
 extracting: etc/opt/microfocus/ps_transform_mgr/config/security/tmKeystore.jks
 extracting: etc/sysconfig/postgresql
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/webapp.ini
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/servlet.ini
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/https.ini
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/jaas.ini
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/ssl.ini.bak
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/servlets.ini
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/http.ini
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/annotations.ini
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/ssl.ini
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/logging.ini
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/gzip.ini
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/start.d/https.ini.bak
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/resources/logging.properties
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/resources/logback.xml
 extracting: opt/microfocus/ps_transform_mgr/tm-jetty-base/resources/jetty-
logging.properties
 extracting: opt/microfocus/migrate_connector/config/settings.cfg
 extracting: opt/microfocus/migrate_connector/custom_callouts/__init__.py
 extracting: opt/microfocus/migrate_connector/custom_callouts/
pre_cutover_testing_callout.py
 extracting: opt/microfocus/migrate_connector/custom_callouts/
submit_validation_callout.py
 extracting: opt/microfocus/migrate_connector/custom_callouts/
post_cutover_testing_callout.py
 extracting: opt/microfocus/migrate_connector/custom_callouts/custom_import_callout.py
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7.3 Deploying a Replacement Appliance VM
To upgrade the PlateSpin Transformation Manager 2 to PlateSpin Transformation Manager 2019.2, 
you can deploy the replacement virtual machine image for the PlateSpin Transformation Manager 
2019.2 Appliance, and re-use Disk 2 (/vastorage).

 Section 7.3.1, “Deploy the PTM VM,” on page 48
 Section 7.3.2, “Edit the PTM VM Properties,” on page 48
 Section 7.3.3, “Configure PTM Appliance Credentials,” on page 49
 Section 7.3.4, “Complete the Upgrade,” on page 49
 Section 7.3.5, “Post Upgrade Configuration Tasks,” on page 50

7.3.1 Deploy the PTM VM
1 In vSphere, copy the extracted OVF file to the new VMware VM folder you created for the 

replacement Appliance VM. 
2 In vSphere, click File > Deploy OVF Template.
3 Click Browse, then navigate to and select the extracted OVF file.
4 Name the replacement Appliance VM with the same name as the parent VM folder you created.
5 Select the same Datastore folder where you copied the Disk 2 .vmdk file.
6 Accept the default for the disk format.
7 Do not select Power on After Deployment.
8 Click Finish.

The VM is created in the VM folder with Disk 1 in the specified Datastore.

7.3.2 Edit the PTM VM Properties
1 In vSphere, right-click the VM you just deployed and select Edit Settings. 

The VM Properties dialog displays the VM properties.
2 Set the Memory and CPU settings to match the old PTM Appliance, or increase them as needed.
3 Configure Disk 2 (/vastorage) to reuse the existing disk:

3a Click Add > Hardware.
3b Select Hard Disk > Next.
3c Select Use an existing Virtual disk, then click Next.
3d Click Browse, then navigate to and select the copy of Disk 2 that you made for the new 

PTM Appliance.
3e Click Next > Next > Finish.
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7.3.3 Configure PTM Appliance Credentials
1 In vSphere, power on the VM.
2 When you are prompted, set the PTM credentials:

2a Set the VM root password.
2b Set the vaadmin root password.

7.3.4 Complete the Upgrade
After you upgrade the software, you must log in as the vaadmin user to the Appliance Management 
Console (on port 9443). The PlateSpin Transformation Manager Complete Upgrade page is presented 
instead of the Appliance Management Console because the Appliance detects that the RPM files for 
PlateSpin Transformation Manager have been modified. You must complete the upgrade before you 
can manage the appliance or log in to the PlateSpin Transformation Manager Web Interface.

1 In the Appliance Management Console, complete the upgrade by running the Transformation 
Manager upgrade script: 
1a In a web browser, connect to the PlateSpin Transformation Manager Appliance 

Management Console and log in as the vaadmin user:
https://<ptm-server-ipaddr-or-fqdn>:9443

1b When you are redirected to the Upgrade page, click Complete Upgrade, then wait for the 
upgrade to complete.
The upgrade automatically stops and restarts the PlateSpin Transformation Manager 
service and the PlateSpin Migrate Connector for PTM service.
The upgrade script performs the following tasks:
 Stops the PlateSpin Transformation Manager service.
 Applies the Transformation Manager upgrade.
 Stops the PlateSpin Migrate Connector service.
 Applies the Migrate Connector upgrade.
 Expands the PTM database schema and applies the changes to your PTM database.

NOTE: If necessary, the upgrade process expands the database schema and applies 
the schema changes to your database. The existing database values are not affected.

 Restarts the Migrate Connector service.
 Restarts the Transformation Manager service.

The process takes about 5 minutes.
2 (Optional) Use a keytool to reset the Jetty keystore settings to what they were before the 

upgrade. Use the values you saved in Section 7.2.1, “Save Jetty Settings,” on page 46.
3 When the upgrade is complete, verify the settings:

3a Log in to the Appliance Management Console and check settings.
3b Log in to PTM Web Interface and check PTM settings and data.

4 Continue with Section 7.3.5, “Post Upgrade Configuration Tasks,” on page 50.
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7.3.5 Post Upgrade Configuration Tasks
1 (Optional) Reapply the Jetty settings you saved in Section 7.2.1, “Save Jetty Settings,” on 

page 46.
2 (Optional) Reapply the custom theme settings as described in Section 7.2.2, “Save Customized 

Default Theme Files,” on page 46.
3 For next steps in the upgrade, refer to the Section 6.4, “PlateSpin Upgrade Checklist,” on 

page 41.
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8 8Upgrading PlateSpin Migrate Connector on 
Host Servers

After you successfully upgrade your PlateSpin Transformation Manager Appliance to version 2019.2, 
you must upgrade existing instances of PlateSpin Migrate Connector from version 2 to version 
2019.2 on each of your Migrate Connector host servers. 

 Section 8.1, “Requirements for Connector Upgrade,” on page 51
 Section 8.2, “Downloading Migrate Connector Software,” on page 52
 Section 8.3, “Upgrading Migrate Connector,” on page 52

8.1 Requirements for Connector Upgrade
PlateSpin Migrate Connector has been written and tested on SUSE Linux Enterprise Server (SLES) 12 
Service Pack 3 (SLES 12 SP3) servers. The software is compatible with any version of SLES 12.

The PlateSpin Migrate Connector 2019.2 installation RPM contains files to upgrade Migrate 
Connector software as well as its dependent software on your existing Migrate Connector host 
servers. After the upgrade, you can verify that software versions have been updated or added as 
described in Table 8-1. 

Table 8-1   Upgraded Dependent Software for the PlateSpin Migrate Connector

Prerequisite Software Package Version Required for PMC 2 Version Required for PMC 2019.2

certifi 2018.1.18 2018.11.29

connexion 1.3 2.2.0

cryptography 2.2 2.4.2

idna Not used 2.8

impacket 0.9.15 0.9.18

ldap3 Not used 2.5.1

lxml 4.2.0 4.3.0

mock 2.0.0 2.0.0

paramiko 2.4.1 2.4.2

pycrypto 2.6.1 2.6.1

pypsexec Not used 0.1.0

pysmb 1.1.22 Not used

python-dateutil 2.7.0 2.7.5
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8.2 Downloading Migrate Connector Software
The RPM files for PlateSpin Migrate Connector 2019.2 are available on the Micro Focus Download 
website (https://download.microfocus.com/) under an entry for PlateSpin Transformation Manager 
2019.2. A public Internet connection is required for download. Log in using the credentials for your 
Micro Focus Customer Center account. 

For information, see Section 2.1, “Downloading the PTM Software,” on page 21.

NOTE: If you applied the public key prior to the installation of PlateSpin Migrate Connector 2 on the 
Migrate Connector host server, you do not need to download key file. The new Connector RPM file 
will install without security warnings. 

8.3 Upgrading Migrate Connector
Before you upgrade PlateSpin Migrate Connector on an existing Connector host server, ensure that 
you have downloaded the files for PlateSpin Migrate Connector 2019.2. The upgrade does not 
overwrite your Connector configuration settings file.

 Section 8.3.1, “Upgrade the Migrate Connector Software,” on page 52
 Section 8.3.2, “Verify the Migrate Connector Status in PTM,” on page 53

8.3.1 Upgrade the Migrate Connector Software
To upgrade the Migrate Connector software on each Migrate Connect host, in turn:

1 Log in as a user with root user privileges on the Migrate Connector host server.

python-ntlm 1.1.0 1.1.0

pytz 2018.3 2018.9

pyvmomi 6.5 6.7.1

requests 2.18.4 2.21.0

requests-ntlm 1.1.0 1.1.0

scp 0.10.2 0.13.0

six 1.11.0 1.12.0

smbprotocol Not used 0.1.1

stomp.py 4.1.20 4.1.21

tzlocal 1.5.1 1.5.1

urllib 3.1.22 Not used

urllib3 Not used 1.24.1

Prerequisite Software Package Version Required for PMC 2 Version Required for PMC 2019.2
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2 Copy the files that you downloaded to a location on the Migrate Connector host server.
3 Launch a terminal console, then navigate to the location where you copied the files.
4 (Optional) Import the PTM Public Key to your keyring.

If you applied the public key prior to the installation of PlateSpin Migrate Connector 2 on the 
existing Connector host server, you do not need to re-import the key. The new RPM file will 
apply the upgrade without security warnings. 
Launch a terminal, then enter one of the following commands as the root user:

gpg --import <ptm-public-key-filename>

or

rpm --import <ptm-public-key-filename>
5 Upgrade the PlateSpin Migrate Connector software and its dependent software. In a console, 

enter

rpm -Uvh <ps-migrate-connector-rpm-filename>
Replace xxx.x with the actual build numbers.
The upgrade does not overwrite your Connector configuration settings file.

6 (Optional) Visually verify that the dependent software is upgraded. 
See Table 8-1, “Upgraded Dependent Software for the PlateSpin Migrate Connector,” on 
page 51.

7 Repeat the upgrade process for each Migrate Connector host server.
8 Continue with Section 8.3.2, “Verify the Migrate Connector Status in PTM,” on page 53.

8.3.2 Verify the Migrate Connector Status in PTM
To verify the Connector status in PTM:

1 Log in to the PTM Web Interface as a user with PTM Administrator privileges.
2 Select Configuration, then select Connectors.
3 View the status of each Migrate Connector instance. 
4 Ensure that each Connector is running and connected to the PTM Server.
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9 9Upgrading PlateSpin Migrate Servers

In a PlateSpin Migration Factory deployment, you must upgrade each of your PlateSpin Migrate 
Servers from version 2018.11 to version 2019.2. You can begin the upgrade for a Migrate server after 
you upgrade its associated PlateSpin Migrate Connector.

For requirements and instructions, see “Upgrading PlateSpin Migrate” in the PlateSpin Migrate 
2019.2 Installation and Upgrade Guide.
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III IIIManage PTM Server Application

PlateSpin Transformation Manager Appliance automatically installs the PlateSpin Transformation 
Manager Server application. It includes a tool to manage basic settings for the PTM server. You can 
also modify files on the Appliance that control the look and feel of the PTM Web Interface.

 Chapter 10, “Managing PTM Server,” on page 59
 Chapter 11, “Configuring a Custom UI Theme for the Web Interface,” on page 65
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10 10Managing PTM Server

The PlateSpin Transformation Manager Appliance provides additional tools to manage the PlateSpin 
Transformation Manager Server that it hosts.

To access the PlateSpin Transformation Manager Tools:

1 In a web browser, specify the DNS name or the IP address for the PTM Appliance with the port 
number 9443. For example:
https://10.10.10.1:9443
or
https://ptm.example.com:9443

2 Specify the administrative username and password for the PTM Appliance, then click Sign in. 
The default users are vaadmin or root.

3 Under PlateSpin Transformation Manager Tools, click Configuration .
4 (Conditional) The Appliance Management Console automatically opens the following PlateSpin 

Transformation Manager Tools if it detects the stated condition:
 Initial Configuration: The Initial Configuration tool opens if the PlateSpin Transformation 

Manager Server has not been configured. You must complete the initial setup before you 
can manage the appliance or the PlateSpin Transformation Manager Server.

 Upgrade: The Upgrade tool opens if the RPM files for PlateSpin Transformation Manager or 
for the guest operating system have been updated by applying patches, support packs, or 
new versions to your existing appliance. You must complete the upgrade before you can 
manage the appliance or the PTM Server.

5 Continue using the PlateSpin Transformation Manager Server Tools.
 Administrative Users for the Web Interface
 Web Server Configuration

Refer to the following sections to manage the PlateSpin Transformation Manager service:

 Section 10.1, “Administrative Users for the Web Interface,” on page 60
 Section 10.2, “Web Server Configuration,” on page 60
 Section 10.3, “Web Interface Session Timeout,” on page 61
 Section 10.4, “Stopping, Starting, or Restarting PTM Service,” on page 61
 Section 10.5, “Stopping, Starting, or Restarting Migrate Connector Service,” on page 62
 Section 10.6, “Reconfigure PTM Server,” on page 62
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10.1 Administrative Users for the Web Interface
During the initial configuration of PlateSpin Transformation Manager Server, you create a default 
System Administrator user account for the PTM Server Web Interface. The login credentials are the 
email address and password you assigned for this user. PTM assigns the user to the System 
Administrator role and adds it as a default member of the Administrators group. The user has global 
permissions for all organizations, projects, and features throughout the Web Interface. The user 
cannot be deleted.

Log in to the Web Interface as the System Administrator user to set up other user accounts, as well 
as organizations and groups. To grant Administrator privileges to a trusted user, add the user account 
to the Administrators group.

NOTE: Members of the Administrators group inherit the System Administrator role and will also 
have global permissions in the Web Interface. Members can manage membership in the 
Administrators group, but they cannot remove the System Administrator user as a member and 
cannot delete the group.

You might need to add a new System Administrator user to the PlateSpin Transformation Manager 
Server if you forget the username and password for the initial System Administrator, or if that initial 
user is no longer available to manage the PTM Server application. The new user has the same global 
privileges as the default System Administrator user.

To add a System Administrator user for the PTM Web Interface:

1 Log in to the Appliance Management Console as the vaadmin user.

2 Under PlateSpin Transformation Manager Tools, click Configuration .
3 On the PlateSpin Transformation Manager Configuration page, select Administrative Users.
4 Provide the full name, a valid email address that is unique to your PlateSpin Transformation 

Manager environment, and a password for this user.
5 Click Submit.

10.2 Web Server Configuration
The administrative users of the PlateSpin Transformation Manager Appliance can reconfigure the 
Jetty Web Server HTTPS and HTTP ports for the Web Interface.

1 Log in to the Appliance Management Console as the vaadmin user.

2 Under PlateSpin Transformation Manager Tools, click Configuration .
3 On the PlateSpin Transformation Manager Configuration page, select Web Server Configuration.
4 For the Web Console HTTPS Port, specify the port to use for secure SSL connections with the 

PlateSpin Transformation Manager Web Interface. The default port is 8183
5 (Optional, not recommended) Select Enable HTTP to allow users to access the PlateSpin 

Transformation Manager Web Interface over port 8182 for non-secure connections.
6 Click Submit.
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10.3 Web Interface Session Timeout
A user session in the PlateSpin Transformation Manager Web Interface times out by default after 30 
minutes of browser inactivity. The Web Interface Session Timeout interval is configurable with the 
tm.session.timeout.minutes property in the /opt/microfocus/ps_transform_mgr/
config/system.properties file. If the property is not specified in this file, the session timeout 
defaults to 30 minutes.

1 Enable the SSH service on the Appliance VM.
See Section 12.4.4, “Enabling or Disabling the SSH Service,” on page 76.

2 Start an SSH session with the Appliance VM, then log in as the vaadmin user or root user.
3 Navigate to the /opt/microfocus/ps_transform_mgr/config/ directory.
4 Open the system.properties file in a text editor.
5 Add the tm.session.timeout.minutes property and specify the value in minutes to set the 

interval of browser inactivity to allow before a Web Interface session times out.
6 Save the file and close the text editor.
7 Restart the PlateSpin Transformation Manager service to allow the Web Interface Session 

Timeout value to take effect.
In your SSH session, enter the following at a terminal console:

rcps_transform_mgr restart
8 Exit your SSH session.
9 (Optional) Disable the SSH service on the Appliance VM.

See Section 12.4.4, “Enabling or Disabling the SSH Service,” on page 76.

10.4 Stopping, Starting, or Restarting PTM Service
System Services

You can stop, start, or restart the PlateSpin Transformation Manager service on the Appliance by 
using System Services in the Appliance Management Console. See Section 12.4.1, “Starting, 
Stopping, or Restarting System Services,” on page 75.

Command Line

You can stop, start, or restart the PlateSpin Transformation Manager service on the Appliance by 
using the /etc/init.d/ps_transform_mgr or rcps_transform_mgr commands, with the 
options stop, start, or restart. Log in as root in an SSH session, the launch a terminal console.
Managing PTM Server 61



10.5 Stopping, Starting, or Restarting Migrate Connector 
Service
System Services

You can stop, start, or restart the PlateSpin Migrate Connector service on the Appliance by using 
System Services in the Appliance Management Console. See Section 12.4.1, “Starting, Stopping, or 
Restarting System Services,” on page 75.

Command Line

You can stop, start, or restart the PlateSpin Migrate Connector service on the Appliance by using the 
/etc/init.d/ps_migrate_connector or rcps_migrate_connector commands, with the 
options stop, start, or restart. Log in as root in an SSH session, the launch a terminal console.

10.6 Reconfigure PTM Server
After the initial configuration, you can reconfigure the PlateSpin Transformation Manager Server 
settings. You should use the Administrative Users tool and the Web Server Configuration tool instead 
to modify the application settings without losing any data.

WARNING: A reconfiguration restores the PlateSpin Transformation Manager application and its 
PostgreSQL database to their initial state. All data is lost.

1 Log in to the Appliance Management Console as the vaadmin user.

2 Under PlateSpin Transformation Manager Tools, click Configuration .
3 On the PlateSpin Transformation Manager Configuration page, select Initial Configuration.
4 Select Overwrite Configuration.

This option is available if the PlateSpin Transformation Manager application is already 
configured.

NOTE: Select this option only if you want to overwrite the existing configuration settings and 
delete all project data.

5 Complete the information for the reconfiguration of the PTM Server.

5a PostgreSQL Database Connection
Use one of the following options:
 Local database: PlateSpin Transformation Manager automatically pre-installs the 

PostgreSQL database on the appliance. Select Auto Setup Local Database to 
automatically create a database instance, database administrator user, and a 
password for the user. Table 10-1 shows the default settings.
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Table 10-1   PostgreSQL Database Default Values

 Remote database: You can alternatively set up the PlateSpin Transformation Manager 
database as a database instance on an existing PostgreSQL database in your network.

1. Deselect Auto Setup Local Database.
2. Replace localhost with the DNS name or IP address of the host server for the 

remote PostgreSQL database, and specify the PostgreSQL port.
3. Specify the credentials of the database administrator user who has the schema 

rights necessary to create a new instance for the PlateSpin Transformation 
Manager database.

4. Specify a name for the PlateSpin Transformation Manager database instance 
(default: transmgr).

5. Specify the user name and password for the database administrator user account 
(default: tmadmin) that will be created for the newly created PlateSpin 
Transformation Manager database instance.

5b Initial User Configuration
The initial user for the PlateSpin Transformation Manager Server is the PTM System 
Administrator user. This user has global permissions for all organizations, projects, and 
features throughout the Web Interface.
Provide the full name, a valid email address that is unique to your PlateSpin Transformation 
Manager environment, and a password for this user.
You cannot delete the System Administrator user account. However, you can add another 
System Administrator user for the PlateSpin Transformation Manager Server if necessary. 
See “Administrative Users for the Web Interface”.

NOTE: You create other PTM users from the Users page in the PlateSpin Transformation 
Manager Web Interface. You can grant Administrator privileges to trusted users by adding 
them to the Administrators group.

Parameter Default Value

Database Host localhost

Database Port 5432

Create a New Database Selected

Database Name transmgr

Database User Name tmadmin
Managing PTM Server 63



5c Web Server Configuration
Micro Focus recommends that you use the secure port 8183 and SSL options for accessing 
the Web Interface. You can enable or disable the HTTP port 8182 to allow non-secure 
traffic.
Specify the DNS name for the PlateSpin Transformation Manager Server. It is populated 
automatically with the DNS address used as the subject of the SSL certificate on the 
appliance.

6 Click Submit.
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11 11Configuring a Custom UI Theme for the 
Web Interface

PlateSpin Transformation Manager enables you to create a custom look-and-feel for the Web 
Interface to suit your business needs. You can specify preferences for the following aspects of the UI 
theme:

 Product name
 Icons for various objects in the Configuration, Dashboard, Resources, Projects, Users, and 

Workloads pages
 Color settings that affect text, titles, underscores, buttons, shadings, and so on throughout the 

interface

The configurable components reside on the PlateSpin Transformation Manager Appliance.

Use the information in this section to understand how to set up and implement your custom UI 
theme.

 Section 11.1, “Configurable Theme Components,” on page 65
 Section 11.2, “Setting Up Your Custom Theme,” on page 66
 Section 11.3, “Resetting Your Custom Theme after an Upgrade,” on page 67

11.1 Configurable Theme Components
PlateSpin Transformation Manager allows you to create a custom look-and-feel for the Web 
Interface. You copy the default theme files to a new directory, customize the files as appropriate, and 
then point to the custom theme location in the Web Interface configuration file.

PlateSpin Transformation Manager provides two key configurable components for the Web Interface 
theme. The configurable components reside on the PlateSpin Transformation Manager Appliance.

 Theme folder: /vastorage/ptm/themes/<your_theme_directory>/
 Color variables: A custom CSS file defines about 20 colors that, along with their derivative 

colors, affect about 80 percent of text, titles, underscores, buttons, shadings, and so on 
throughout the Web Interface. You can modify the color definitions to suit the color 
scheme for your business.

 Images: You can replace any of the various images related to icons displayed for 
configuration, dashboard, resources, projects, users, and workloads.

 Theme configuration file: /etc/opt/microfocus/ps_transform_mgr/config/
transformationmanager-themes.cfg
 Product Name: You can specify the full and short product name that displays in the Web 

Interface.
 Theme: You can specify the default TransformationManager theme directory, or 

specify your custom theme directory.
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11.2 Setting Up Your Custom Theme
To create a custom theme for the PTM Web Interface:

1 Enable the SSH service on the appliance:
1a Log in to the Appliance Management Console as the vaadmin user.
1b Click System Services.
1c Select the SSH service.
1d Select Action > Start.
1e Click Close to exit System Services.

2 Start an SSH session and log in as the vaadmin user to the user appliance.
3 Set up your custom theme files:

3a Navigate to the /vastorage/ptm/themes/ directory.
3b Create a subdirectory under themes for your custom theme, such as MyCompanyTheme.
3c Copy the contents of the /vastorage/ptm/themes/TransformationManager 

directory to your new theme directory (/vastorage/ptm/themes/MyCompanyTheme).
3d In your custom theme directory, update the custom CSS file for color variables;

/vastorage/ptm/themes/<your_theme_directory>/en/web/
theme_variables.tmcss

3e In your custom theme directory, change the image files as appropriate to define your 
custom theme for the PTM Web Interface.

4 Modify the transformationmanager-themes.cfg file with your custom settings:
4a Open the /etc/opt/microfocus/ps_transform_mgr/config/

transformationmanager-themes.cfg file in a text editor.
4b Modify the server.theme directive to replace the TransformationManager theme 

with your custom theme MyCompanyTheme.
For example, change this line:

server.theme=TransformationManager
to this:

server.theme=MyCompanyTheme
4c (Optional) Modify the lines that specify the product name.

server.productname=<span>PlateSpin</span> Transformation Manager
server.shortproductname=Transformation Manager

4d Save your changes.
5 Restart the PlateSpin Transformation Manager service to allow the theme changes to take 

effect.
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Do one of the following:
 In your SSH session, enter the following at a terminal console:

rcps_transform_mgr restart
 Log in to the Appliance Management Console, click System Services, select PlateSpin 

Transformation Manager (ps_transform_mgr), then select Action > Restart.
6 Log in to the PTM Web Interface to verify your UI changes.

To make additional changes, return to the appliance to update your custom theme files as 
appropriate, then restart the service to apply the changes.

7 After your theme changes are complete, end your SSH session.
8 Disable the SSH service:

8a Log in to the Appliance Management Console as the vaadmin user, then click System 
Services.

8b Select the SSH service.
8c Select Action > Stop.
8d Click Close to exit System Services.
8e Log out of the Appliance Management Console, then close your web browser.

11.3 Resetting Your Custom Theme after an Upgrade
An appliance update ignores your custom theme directory, but updates files in the default theme 
location. After an upgrade or update, you must verify that your themes are still valid and manually 
update your theme files as necessary.

NOTE: If you edited the default theme, you must reapply the settings after upgrade. Go to the 
default theme location (/vastorage/ptm/themes/ directory). Refer to the files you saved in 
Section 7.2.2, “Save Customized Default Theme Files,” on page 46.

After a patch or online update, manually update your theme:

1 Enable the SSH service on the appliance:
1a Log in to the Appliance Management Console as the vaadmin user, then click System 

Services.
1b Select the SSH service.
1c Select Action > Start.
1d Click Close to exit System Services.

2 Start an SSH session and log in as the vaadmin user to the appliance.
3 Navigate to the /vastorage/ptm/themes/TransformationManager directory.
4 Copy the latest version of the CSS and image files that you modified from the 
TransformationManager location to a working location.

5 Merge your custom settings to these new files.
6 Copy the updated files to your theme directory (/vastorage/ptm/themes/
MyCompanyTheme).
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7 If you are using a custom theme (not an edited default theme), edit the /etc/opt/
microfocus/ps_transform_mgr/config/transformationmanager-themes.cfg file 
to point again to your custom theme.

8 Restart the PlateSpin Transformation Manager service to allow the theme changes to take 
effect.
Do one of the following:
 In your SSH session, enter the following at a terminal console:

rcps_transform_mgr restart
 Log in to the Appliance Management Console, click System Services, select PlateSpin 

Transformation Manager (ps_transform_mgr), then select Action > Restart.
9 Log in to the PTM Web Interface to verify your UI changes.

To make additional changes, return to the appliance to update your custom theme files as 
appropriate, then restart the service to apply the changes.

10 After the theme changes are complete, end your SSH session.
11 Disable the SSH service:

11a Log in to the Appliance Management Console as the vaadmin user, then click System 
Services.

11b Select the SSH service.
11c Select Action > Stop.
11d Click Close to exit System Services.
11e Log out of the Appliance Management Console, then close your web browser.
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IV IVManage PTM Appliance

PlateSpin Transformation Manager provides an Appliance Management Console with various 
options for managing and updating the Appliance. It enables you to configure services for the server 
without working directly in the Linux interface.

 Chapter 12, “Managing PTM Appliance,” on page 71
 Chapter 13, “Patching the Appliance,” on page 85
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12 12Managing PTM Appliance

The PlateSpin Transformation Manager Appliance is the virtual machine that hosts the PlateSpin 
Transformation Manager Server and its database. You can use the Appliance Management Console 
to change certain configuration settings for the PTM Appliance, such as administrative passwords for 
the vaadmin user and root user, network settings, and certificate settings. You should perform 
these tasks only from the Console, because native Linux tools are not aware of the configuration 
requirements and dependencies of the PlateSpin Transformation Manager services.

To access the Appliance Management Console:

1 In a web browser, specify the DNS name or the IP address for the PTM Appliance with the port 
number 9443.
https://<ptm-ipaddr-or-dns-name>:9443
For example:
https://10.10.10.1:9443
or
https://ptm.example.com:9443

2 Specify the administrative username and password for the PTM Appliance, then click Sign in. 
The default users are vaadmin or root.

3 (Conditional) The Appliance Management Console automatically displays one the following 
PlateSpin Transformation Manager options if it detects the stated condition:
 Initial Configuration: The Initial Configuration tool opens if the PlateSpin Transformation 

Manager Server has not yet been configured. You must complete the initial setup before 
you can manage the appliance or the PlateSpin Transformation Manager Server.

 Upgrade: The Upgrade tool opens if the RPM files for PlateSpin Transformation Manager or 
for the guest operating system have been updated by applying patches, support packs, or 
new versions to your existing appliance. You must complete the upgrade before you can 
manage the appliance or the PTM Server.

4 Continue using the Appliance Configuration tools in the Appliance Management Console.

The Appliance Management Console provides web-based configuration tools for the PTM Appliance:

 Administrative Passwords
 Network
 Time
 System Services
 Digital Certificates
 Firewall
 Ganglia Configuration and Monitoring
 Storage
 /var Mount Configuration
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 Reboot or Shutdown
 Logout

See also the following topics in Chapter 13, “Patching the Appliance,” on page 85:

 Support
 Field Patch
 Online Update

12.1 Administrative Passwords
Use the Administrative Passwords tool to modify the passwords and SSH access permissions for the 
PTM Appliance administrators: the vaadmin user and the root user. You might need to modify 
passwords periodically in keeping with your password policy, or if you reassign responsibility for the 
PTM Appliance administration to another person.

The vaadmin user can use the Administrative Passwords page to perform the following task:
 Modify the vaadmin user password. To change a password, you must be able to provide the old 

password.
 The vaadmin user automatically has permissions necessary to remotely access the appliance 

with SSH instead of using a VMware client. The SSH service must be enabled and running to 
allow SSH access.

NOTE: The SSH service is disabled and is not running by default. For information about how to 
start SSH on the appliance, see Section 12.4, “System Services,” on page 74.

The root user can use the Administrative Passwords page to perform the following tasks:
 Modify the root user password. To change a password, you must be able to provide the old 

password.
 Enable or disable (default) root user SSH access to the appliance.

When this option is selected, the root user is able to SSH to the appliance. If this option is 
deselected, only the vaadmin user can SSH to the appliance, and the root user cannot SSH even 
if the sshd service is running.

To manage the administrative access as the vaadmin user:

1 Log in to the Appliance Management Console as the vaadmin user.

2 Click Administrative Passwords .
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3 Specify a new password for the vaadmin administrator. You must also specify the current 
vaadmin password.

4 Click OK.

To manage the administrative access as the root user:

1 Log in to the Appliance Management Console as the root user.

2 Click Administrative Passwords .
3 Specify a new password for the root administrator. You must also specify the current root 

password.
4 (Optional) Select or deselect Allow root access to SSH. It is deselected by default.
5 Click OK.

12.2 Network
Use the Network tool to configure settings for the DNS servers, search domains, gateway, and NICs 
for the PTM Appliance. You might need to modify these settings after the initial setup if you move 
the appliance VM to a new host server, or move the host server to a new domain in your network 
environment. You can also optionally restrict the networks that are allowed to access the appliance.

To configure network settings for the PTM Appliance:

1 Log in to the Appliance Management Console as the vaadmin user.

2 Click Network .
3 In the DNS Configuration section, you can modify the DNS name servers, search domains, and 

gateway settings for your appliance network.
If the Search Domains field is left blank, it is auto-populated with the domain of the appliance 
host name. For example, if the host name of the appliance is ptm.mycompany.com, the 
domain is auto-populated with mycompany.com.

4 In the NIC Configuration section, you can modify the IP address, host name, and network mask 
of any NIC associated with the appliance.
4a Click the ID of the NIC.
4b Edit the IP address, host name, or network mask for the selected NIC.
4c Click OK.
4d Repeat these steps for each NIC that you want to configure.
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5 (Optional) In the Appliance Administration UI (port 9443) Access Restrictions section, do one of 
the following:
 Specify the IP address of each network for which you want to allow access to the appliance. 

Only the listed networks are allowed.
 Leave this section blank to allow any network to access the appliance.

NOTE: After you configure the appliance, changes to your appliance network environment can 
impact the appliance communications.

6 Click OK.

12.3 Time
Use the Time tool to configure the Network Time Protocol (NTP) server, the geographic region, and 
the time zone where you have deployed the appliance.

To configure time parameters for the PTM Appliance:

1 Log in to the Appliance Management Console as the vaadmin user.

2 Click Time .
3 Change the following time configuration options as appropriate:

NTP Server: Specify the NTP server that you want to use for time synchronization.
Region: Select the geographic region where your appliance is located.
Time Zone: Select the time zone where your appliance is located.

4 Click OK.

12.4 System Services
Use the System Services tool to view the status of services running on the appliance, or performs on 
them. System services include the following:

 SSH
 Jetty
 PostgreSQL
 PlateSpin Transformation Manager
 PlateSpin Migrate Connector for PTM
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To access the System Services page:

1 Log in to the Appliance Management Console as the vaadmin user.

2 Click System Services .

You can perform the following actions:

 Section 12.4.1, “Starting, Stopping, or Restarting System Services,” on page 75
 Section 12.4.2, “Making System Services Automatic or Manual,” on page 76
 Section 12.4.3, “Downloading Log Files for System Services,” on page 76
 Section 12.4.4, “Enabling or Disabling the SSH Service,” on page 76

12.4.1 Starting, Stopping, or Restarting System Services
You might want to start, stop, or restart the following services:

 SSH (disabled by default)
 Jetty
 PostgreSQL
 PlateSpin Transformation Manager
 PlateSpin Migrate Connector for PTM

For example, if you create a custom theme for the PTM Web Interface, you will enable and disable 
SSH and restart PlateSpin Transformation Manager as part of the setup process.

To start, stop, or restart a service on the appliance:

1 Click System Services .
2 Select the service that you want to start, stop, or restart.

 SSH (disabled by default)
 Jetty
 PostgreSQL
 PlateSpin Transformation Manager
 PlateSpin Migrate Connector for PTM

3 Click Action, then select Start, Stop, or Restart.
4 Click Close to exit System Services.
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12.4.2 Making System Services Automatic or Manual

1 Click System Services .
2 Select the service that you want to make automatic or manual.
3 Click Options, then select either Set as Automatic or Set as Manual.
4 Click Close to exit System Services.

12.4.3 Downloading Log Files for System Services
If you experience an issue with the Web Interface, you might need to download the log files to send 
them to Technical Support.

1 Click System Services .
2 In the Log Files column, click the download link for the appropriate service to download the log 

files to your management workstation:
SSH: The SSH service that is running on the appliance has no relevant log files for download.
Jetty: Downloads the jetty.stderrout.log file.
PostgreSQL: The database for the PlateSpin Transformation Manager product has no relevant 
log files for download.
PlateSpin Transformation Manager: Collects, zips, and downloads the following log files:
 tm_server.log
 platespin-transformmgr.out
 platespin_transformmgr_config.log

PlateSpin Migrate Connector for PTM: Collects, zips, and downloads the following log files:
 migrate_connector.log
 platespin-migrate-connector.out

3 Click Close to exit System Services.

12.4.4 Enabling or Disabling the SSH Service
To enable the SSH service on the Appliance VM:

1 Log in to the Appliance Management Console as the vaadmin user, then click System Services.
2 Select the SSH service.
3 Select Action > Start.
4 Click Options, then select either Set as Automatic or Set as Manual.
5 Click Close to exit System Services.
6 Log out of the Appliance Management Console, then close your web browser.
7 From your computer, start an SSH session and log in as the vaadmin user or root user to the 

user appliance.
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To disable the SSH service on the Appliance VM:

1 Exit any open SSH sessions.
2 Log in to the Appliance Management Console as the vaadmin user, then click System Services.
3 Select the SSH service.
4 Select Action > Stop.
5 Click Close to exit System Services.
6 Log out of the Appliance Management Console, then close your web browser.

12.5 Digital Certificates
Use the Digital Certificates tool to add and activate certificates for the PTM Appliance. You can use 
the digital certificate tool to create your own certificate and then have it signed by a CA, or you can 
use an existing certificate and key pair if you have one that you want to use.

NOTE: The appliance ships with a self-signed digital certificate. Instead of using this self-signed 
certificate, Micro Focus recommends that you use a trusted server certificate that is signed by a 
trusted certificate authority (CA) such as VeriSign or Equifax.

The certificate works for both the appliance (port 9443) and the PlateSpin Transformation Manager 
Web Interface (ports 8182 and 8183). You do not need to update your certificate when you update 
the software.

Complete the following sections to change the digital certificate for your appliance:

 Section 12.5.1, “Using the Digital Certificate Tool,” on page 77
 Section 12.5.2, “Using an Existing Certificate and Key Pair,” on page 79
 Section 12.5.3, “Activating the Certificate,” on page 79

12.5.1 Using the Digital Certificate Tool
 “Creating a New Self-Signed Certificate” on page 77
 “Getting Your Certificate Officially Signed” on page 78

Creating a New Self-Signed Certificate
1 Log in to the Appliance Management Console as the vaadmin user.

2 Click Digital Certificates .
3 In the Key Store drop-down list, ensure that Web Application Certificates is selected.
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4 Click File > New Certificate (Key Pair), then specify the following information:

4a General
Alias: Specify a name that you want to use to identify and manage this certificate.
Validity (days): Specify how long you want the certificate to remain valid.

4b Algorithm Details
Key Algorithm: Select either RSA or DSA.
Key Size: Select the desired key size.
Signature Algorithm: Select the desired signature algorithm.

4c Owner Information
Common Name (CN): This must match the server name in the URL in order for browsers to 
accept the certificate for SSL communication.
Organizational Unit (OU): (Optional) Small organization name, such as a department or 
division. For example, Purchasing.
Organization (O): (Optional) Large organization name. For example, Micro Focus.
City or Locality (L): (Optional) City name. For example, Provo.
State or Province (ST): (Optional) State or province name. For example, Utah.
Two-letter Country Code (C): (Optional) Two-letter country code. For example, US.

5 Click OK to create the certificate.
After the certificate is created, it is self-signed.

6 Make the certificate official, as described in “Getting Your Certificate Officially Signed” on 
page 78.

Getting Your Certificate Officially Signed
1 On the Digital Certificates page, select the certificate that you just created, then click File > 

Certificate Requests > Generate CSR.
2 Complete the process of emailing your digital certificate to a certificate authority (CA), such as 

Verisign.
The CA takes your Certificate Signing Request (CSR) and generates an official certificate based 
on the information in the CSR. The CA then mails the new certificate and certificate chain back 
to you.

3 After you have received the official certificate and certificate chain from the CA:
3a Revisit the Digital Certificates page.
3b Click File > Import > Trusted Certificate. Browse to the trusted certificate chain that you 

received from the CA, then click OK.
3c Select the self-signed certificate, then click File > Certification Request > Import CA Reply.
3d Browse to and upload the official certificate to be used to update the certificate 

information.
On the Digital Certificates page, the name in the Issuer column for your certificate changes 
to the name of the CA that stamped your certificate.

4 Activate the certificate, as described in Section 12.5.3, “Activating the Certificate,” on page 79.
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12.5.2 Using an Existing Certificate and Key Pair
When you use an existing certificate and key pair, use a .P12 key pair format.

1 Log in to the Appliance Management Console as the vaadmin user.

2 Click Digital Certificates .
3 In the Key Store drop-down menu, select JVM Certificates.
4 Click File > Import > Trusted Certificate. Browse to and select your existing certificate, then click 

OK.
5 Click File > Import > Trusted Certificate. Browse to and select your existing certificate chain for 

the certificate that you selected in Step 4, then click OK.
6 Click File > Import > Key Pair. Browse to and select your .P12 key pair file, specify your 

password if needed, then click OK.
7 Continue with Section 12.5.3, “Activating the Certificate,” on page 79.

12.5.3 Activating the Certificate
1 On the Digital Certificates page, in the Key Store drop-down menu, select Web Application 

Certificates.
2 Select the certificate that you want to make active, click Set as Active, then click Yes.
3 Verify that the certificate and the certificate chain were created correctly by selecting the 

certificate and clicking View Info.
4 When you successfully activate the certificate, click Close to exit Digital Certificates.

12.6 Firewall
Use the Firewall tool to view your current firewall configuration directly from the appliance. By 
default, all ports are blocked except those needed by the appliance. For example, the Login page for 
the Appliance Management Console uses port 9443, so this port is open by default.

NOTE: To have a seamless experience with the appliance, ensure that you do not block the ports 
with your firewall settings. See “Appliance Management Console: Ports and Firewalls” on page 17.

To view firewall settings for the PTM Appliance:

1 Log in to the Appliance Management Console as the vaadmin user.
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2 Click Firewall .
The Firewall page lists port numbers with the current status of each port number. The page is 
for informational purposes and is not editable.

3 Click Close to exit the Firewall page

12.7 Ganglia Configuration and Monitoring
Ganglia is a scalable, distributed monitoring system that allows you to gather important information 
about your appliance. The default metrics that you can monitor are CPU, disk, load, memory, 
network, and process.

 Section 12.7.1, “Configure Ganglia,” on page 80
 Section 12.7.2, “View Ganglia Metrics Using the Appliance Management Console Port 9443 

(Secure),” on page 81
 Section 12.7.3, “View Ganglia Metrics Directly Using Port 9080 (Not Secure),” on page 82

12.7.1 Configure Ganglia
Use the Ganglia Configuration tool to configure monitoring for the PTM Appliance. The Ganglia 
gmond daemon uses UDP port 8649 for communications. The gmetad daemon uses TCP port 8649 
for metrics data. You can also enable or disable non-secure HTTP viewing of the metrics on port 
9080.

1 Log in to the Appliance Management Console as the vaadmin user.

2 Click Ganglia Configuration .
3 As appropriate, change the following Ganglia configuration options:

Monitoring Services
 Enable Full Monitoring Services: Select this option to receive and store metrics from other 

appliances, and to allow the Ganglia Web Interface to run on the appliance. This option is 
enabled by default.
You might want to disable Ganglia monitoring by deselecting this option:
 If you already have a monitoring system that you plan to use for the PTM Appliance.
 If you plan to configure a dedicated appliance for viewing monitoring information.

You specify a dedicated appliance by selecting Unicast under Monitoring Options, and 
then specifying the DNS name or IP address of the appliance that collects the 
monitoring information.
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Monitoring Options
 Enable monitoring on this appliance: Select this option to enable Ganglia monitoring on 

this appliance.
 Multicast: Select this option to send monitoring information to other appliances on 

the network. This option is selected by default.
 Unicast: (Recommended) Select this option to send monitoring information to a single 

destination.

NOTE: Unicast mode is recommended for improving performance of the system.

Publish to: Specify the URL where Ganglia sends monitoring information when it is 
running in Unicast mode.

Monitoring Tool Options
 Enable direct http port 9080 access: Select this option to enable the Ganglia Monitoring 

dashboard to be available directly at the following URL using the non-secure http protocol 
and port 9080:
http://ptm_dns_server_name:9080/gweb/

4 (Optional) Click Reset Database to remove all existing Ganglia metrics from the Ganglia database 
on this appliance.
This option is not related to the PlateSpin Transformation Manager database.

5 Click OK.
6 Click Close to exit Ganglia Configuration.

12.7.2 View Ganglia Metrics Using the Appliance Management Console 
Port 9443 (Secure)
Use the Ganglia Monitoring tool to securely view the Ganglia Dashboard in the Appliance 
Management Console using port 9443. The dashboard displays the health and status metrics for the 
PTM Appliance.

1 Log in to the Appliance Management Console as the vaadmin user.

2 Click Ganglia Monitoring .
The Ganglia Dashboard opens in a new tab to the following web page:
https://ptm_dns_server_name:9443/gweb/

3 When you are done viewing information, close the Ganglia tab in your web browser.
Managing PTM Appliance 81



12.7.3 View Ganglia Metrics Directly Using Port 9080 (Not Secure)
1 Ensure that you have enabled Monitoring Tool Options > Enable direct http port 9080 access.
2 In a web browser, go to the following URL:

http://ptm_dns_server_name:9080/gweb/
No login is required.

3 When you are done viewing information, close your web browser.

12.8 Storage
Use the Storage tool to expand the storage space for the Boot partition (Hard Disk 1) and the /
vastorage (virtual appliance storage) partition (Hard Disk 2) that you created when you deployed 
the appliance. You can also expand the /varpartition if you created a separate disk for the log files.

To expand the size of an appliance disk partitions:

1 Log in to the Appliance Management Console as the vaadmin user.

2 Click Storage .
3 Use the tools provided by your virtualization platform vendor to expand the virtual disks that 

contain the partitions you are expanding.
4 In the virtual disks table, select the partitions to be expanded.
5 Click Expand partitions.

This action stops the appliance services, expands the selected partitions to the size of their 
respective disks, and restarts appliance services.

6 Restart the appliance so the operating system can detect the disks that have been expanded.

12.9 /var Mount Configuration
Use the /var Mount Configuration tool to configure the location of the /var directory if you move 
it to a separate hard disk on the appliance or to a remote NFS directory. By default, the appliance 
logs its system events in the /var directory on the Boot partition (Hard Disk 1). Because the /var 
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directory can fill up with log files and cause the Boot partition to grow, you can locate the /var 
directory on a separate dedicated hard disk on the appliance, or on a dedicated remote NFS 
directory.

To move the /var directory to a dedicated disk or to a remote NFS directory:

1 Use the VMware vSphere client to create a virtual disk and assign it to the appliance's virtual 
machine.

2 Log in to the Appliance Management Console as the vaadmin user.

3 Click /var Mount Configuration .
4 Specify the hard disk information for the /var directory:

 Select disk: Select the hard disk where you want to place the /var directory.
 File system type: Specify the type of file system.

5 Click OK.

12.10 Reboot or Shutdown
You might need to initiate a graceful shut down or to restart the appliance for maintenance. Using 
the Appliance Management Console options is preferred over using a Power Off/On option in the 
hypervisor’s VM management tool.

1 Log in to the Appliance Management Console as the vaadmin user.
2 In the upper right corner of the Appliance Configuration pane, click Reboot or click Shutdown.

12.11 Logout
For security reasons, you should sign out to exit your management session with the appliance, then 
close your web browser. Your session terminates automatically when you close your web browser.

To sign out of the Appliance Management Console:

1 In the upper-right corner of the Appliance Management Console page, next to the user name, 
click Logout.

2 Close the web browser.
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13 13Patching the Appliance

PlateSpin Transformation Manager Appliance provides built-in tools to help you apply field patches 
and patches for the Appliance. You should perform these tasks only from the Appliance 
Management Console, because native Linux tools are not aware of the configuration requirements 
and dependencies of the PlateSpin Transformation Manager services.

To access the Appliance Management Console:

1 In a web browser, specify the DNS name or the IP address for the appliance with the port 
number 9443.
https://<ptm-ipaddr-or-dns-name>:9443
For example:
https://10.10.10.1:9443
or
https://ptm.example.com:9443

2 Specify the administrative username and password for the appliance, then click Sign in. The 
default users are vaadmin or root.

The Appliance System Configuration page displays the following options to help you manage patches 
to the current release version:

 Support
 Field Patch
 Online Update

13.1 Support
Use the Support tool to send configuration information to Technical Support (https://
support.microfocus.com/contact/) by uploading files directly with FTP, or by downloading the files to 
your management workstation and sending them by an alternative method.

To send configuration files to Technical Support:

1 Log in to the Appliance Management Console as the vaadmin user.

2 Click Support .
Patching the Appliance 85

https://support.microfocus.com/contact/


3 Use one of the following methods to send the appliance’s configuration files to Technical 
Support (https://support.microfocus.com/contact/):
 Select Automatically send the configuration to Micro Focus using FTP to initiate the FTP 

transfer of configuration information.
 Select Download and save the configuration file locally, then send it to Micro Focus manually 

to download configuration information to your management workstation. You can then 
send the information to Technical Support (https://support.microfocus.com/contact/) 
using a method of your choice.

4 Click OK to complete the process.

13.2 Field Patch
Use the Field Patch option to manage patches for Transformation Manager Server software, patches 
for the PlateSpin Migrate Connector software for the installed instance, and security patches for the 
software and operating system. You can install new patches, view currently installed patches, and 
uninstall patches. You can download patches from the Micro Focus Patch Finder website (https://
download.microfocus.com/patch/finder/).

To manage patches:

1 Log in to the Appliance Management Console as the vaadmin user.

2 Click Field Patch .
3 (Conditional) Install a downloaded patch:

3a Download the PlateSpin Transformation Manager patch file from the Micro Focus Patch 
Finder website (https://download.microfocus.com/patch/finder/) to your management 
computer.

3b On the Field Patch page in the Install a Downloaded Patch section, click Browse.
3c Browse to and select the patch that you downloaded in Step 3a.
3d Click Install.

4 (Conditional) Uninstall a patch:
You might not be able to uninstall some patches.
4a In the Patch Name column of the Field Patch list, select the patch that you want to 

uninstall.
4b Click Uninstall Latest Patch.

5 (Conditional) Download a log file that includes details about the patch installation.
5a Click Download Log File for the appropriate patch.

6 Click Close to exit the Field Test Patch page.
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13.3 Online Update
PlateSpin Transformation Manager 2019.2 does not support the Update Channel option.
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